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Preface About This Guide
This guide is intended for general business users who need to use a configured InQuira 
Analytics application to report on InQuira application performance. It provides an 
overview of the InQuira Analytics system, describes how to configure an analytics 
processing task in order to populate reports, describes the basic features of the application 
user interface and how to set user preferences, and general information on accessing and 
using both Intelligent Search and Information Manager analytics reports. This section also 
provides a set of scenarios that illustrate the use of InQuira Analytics to achieve various 
business objectives.

This preface includes information on:

• The general organization of this guide

• How to contact InQuira

• The support services available from InQuira Customer Support
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In This Guide

This guide to Using InQuira Analytics is divided into the following sections:

Chapter 1, Introduction to 
InQuira Analytics

This chapter describes the InQuira Analytics business 
intelligence application; its architecture, types of standard 
reports, and general report features

Chapter 2, Configuring 
an Analytics Processing 
Task

This chapter describes the ETL process and how to 
configure an analytics processing task in order to populate 
InQuira Analytics with data. It contains additional 
configuration information. 

Chapter 3, Getting 
Started with InQuira 
Analytics 

This chapter describes the basic information required to use 
InQuira Analytics.

Chapter 4, Utilizing 
InQuira Analytics Reports

This chapter describes, in detail, the capabilities of InQuira 
Analytics.

Chapter 5, InQuira 
Intelligent Search 
Analytics Reports

This chapter explains the InQuira Intelligent Search 
analytics reports and how to make use of them. It also 
contains a set of scenarios that illustrate using InQuira 
Analytics to investigate various business objectives 
associated with different types of users, from product 
managers to system administrators.

Chapter 6, InQuira 
Information Manager 
Analytics Reports

This chapter explains the available analytics reports used for 
InQuira Information Manager. It is divided into Information 
Manager Analytics Reports on page 202 and Information 
Manager Operational Reports on page 236.

Chapter 7, Creating 
Custom Reports

This chapter describes how to modify existing reports, as 
well as how to create new analytics reports.

Chapter 8, The Log Data 
Archive

This chapter describes how to create and access archived 
InQuira Analytics data.
2 Using InQuira Analytics



Contacting InQuira

You can contact InQuira by mail, telephone, fax, and email.

Address: InQuira, Inc. 
900 Cherry Ave., 6th Floor 
San Bruno, CA 94066

Telephone: (650) 246-5000
Fax: (650) 264-5036
Email: For sales information, send email to sales@inquira.com.  

For product support, send email to support@inquira.com.
World Wide Web: Learn more about InQuira products, solutions, services, and 

support on the world wide web at: www.inquira.com.
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InQuira Product Documentation

InQuira documentation is available only to licensed users of our software products and 
may not be redistributed in any form without express permission from InQuira, Inc.

The InQuira documentation is available in PDF format.Customers can download the 
PDF files from: 

http://documentation.inquira.com/

NOTE:  You need a PDF reader application installed on each processor on which you plan 
to view the InQuira product documentation. The Adobe Acrobat reader is available 
from Adobe Systems at: http://www.adobe.com.

Detailed information about each product document set is available in:

• Intelligent Search Documentation on page 4

• InQuira Analytics Documentation on page 6

• Information Manager Documentation on page 7

• Contact Center Documentation on page 8

If you encounter a problem, need help using the documentation, or want to report an error 
in the content, please contact InQuira Customer Support.

If you need help obtaining InQuira product documentation, or want to obtain permission 
to redistribute a portion of the contents, please contact your InQuira account 
representative.

Intelligent Search Documentation

Intelligent Search is distributed with the following documentation.

Document Number Description
Intelligent Search 
Installation Guide

IS80-IG-00 This guide is intended for technical staff who 
are responsible for installing InQuira 8.1. It 
provides detailed information on installing 
InQuira 8.1 and configuring the application on 
a single processor using the Installation 
Configuration Environment facility.
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Intelligent Search 
Administration Guide

IS80-CA-00 This guide is intended for system and 
application administrators who need to 
configure an InQuira 8.1 application in an 
enterprise environment. It describes InQuira 
8.1 integration, development, configuration, 
and maintenance processes and tasks.

Intelligent Search 
Language 
Administration Guide

IS80-LA-00 This guide is intended for business users and 
subject matter experts who need to create and 
maintain the language processing elements of 
an InQuira 8.1 application using the System 
Manager. This book provides usage 
information about the System Manager, 
conceptual information about the InQuira 8.1 
language objects, and task information about 
the process of managing the user experience 
provided by the InQuira 8.1 application. 

Intelligent Search 
Language Tuning 
Guide

IS80-LD-00 This guide is intended for application 
developers who need to create and maintain 
advanced InQuira 8.1 language-processing 
elements using the Dictionary and other 
InQuira Language Workbench applications.

Intelligent Search 
Optimization Guide 

IS80-AG-00 This guide is intended for application 
developers who need to implement InQuira 
8.1 advanced features, including Personalized 
Navigation and Process Wizards.

Intelligent Search 
Application 
Development Guide

IS80-API-00 This guide provides information about 
integrating and customizing the InQuira 8.1 
Personalized Response User Interface.
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InQuira Analytics Documentation

InQuira Analytics is distributed with the following documentation.

Intelligent Search 
Language Reference 

IS80-LRG-00 This guide is for language developers 
implementing InQuira 8.1 applications that 
utilize the intent libraries and advanced 
language processing functions. These guides 
are published as separate documents that 
provide reference information for each 
industry-specific intent library. Each reference 
also contains complete descriptions of InQuira 
Match Language and Variable Instantiation 
Language.

Intelligent Search User 
Interface Guide

IS80-UI-00 This guide is intended for application 
developers who need to customize the InQuira 
8.1 Personalized Response User Interface, and 
integrate it with a production web application. 
It contains information about the elements and 
features of the User Interface, and provides 
guidelines for integrating it into an enterprise 
web architecture, customizing its appearance 
and functionality, and implementing various 
special features.

Document Number Description
InQuira Analytics 
Installation Guide

IA80-IG-00 This guide is intended for technical staff who 
are responsible for installing InQuira Analytics. 
It provides detailed information on installing 
and configuring the InQuira Analytics product 
for use with an InQuira 8.1 application.

Analytics User Guide IA80-CA-00 This guide is intended for systems and 
application administrators who need to 
configure the Intelligent Search and 
Information Manager Analytics components to 
report on InQuira 8.1 application performance.
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Information Manager Documentation

InQuira Information Manager is distributed with the following documentation.

Document Number Description
Information Manager 
Installation Guide

IM80-IG-00 This guide is intended for technical staff who 
are responsible for installing InQuira 
Information Manager. It provides detailed 
information on installing and configuring the 
Information Manager product.

Information Manager 
Administration Guide

IM80-CA-00 This guide is intended for systems and 
application administrators who need to 
configure and administer an InQuira 
Information Manager application, and integrate 
it with an InQuira 8.1 application. It also 
contains information for general business users 
who need to use the Information Manager to 
create and manage content. 

Information Manager 
Content Authoring 
Guide

IM80-AG-00 This guide is intended for technical staff who 
are responsible for authoring content in InQuira 
Information Manager. It provides detailed 
information on creating content and managing 
workflow tasks in the Information Manager 
console.

Information Manager 
Developer’s Guide

IM80-WSR-00 This guide is intended for application 
developers who need to integrate Information 
Manager content, content category, and user 
and security functions with external 
applications. It contains reference information 
and examples for all packages, classes, 
methods, and interfaces of the Information 
Manager Web Services API.
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Contact Center Documentation

The InQuira 8.1 contact center products are distributed with the following documentation.

Screen and Text Representations

The product screens, screen text, and file contents depicted in the documentation are 
examples. We attempt to convey the product's appearance and functionality as accurately 
as possible; however, the actual product contents and displays may differ from the 
published examples.

References to World Wide Web Resources

For your convenience, we refer to Uniform Resource Locators (URLs) for resources 
published on the World Wide Web when appropriate. We attempt to provide accurate 
information; however, these resources are controlled by their respective owners and are 
therefore subject to change at any time.

Document Number Description
Contact Center 
Advisor Integration 
Guide

CA80-IG-00 This guide is intended for application 
developers and systems administrators who 
need to plan for and integrate the InQuira 
Contact Center Advisor with an InQuira 
application and a supported CRM application.

Intelligent Search 
Siebel Integration 
Guide

CAS80-IG-00 This guide is intended for application 
developers and systems administrators who 
need to plan for and integrate InQuira 8.1 with 
Siebel 7 Enterprise Applications using the 
Siebel Adapter for InQuira 8.1.
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Chapter 1 Introduction to InQuira Analytics

InQuira Analytics is a business intelligence application designed specifically to provide 
insight into InQuira application performance. You can use InQuira Analytics to:

• Understand user behavior, such as why users visit your site, and what they try to 
achieve

• Assess the quality of InQuira responses and whether users are finding the information 
they need

• Determine if important information is missing from your application content

• Report on application performance, such as system response times

IMPORTANT:  InQuira Analytics requires an installed and configured InQuira application 
and installed and configured supplementary software as described in the 
InQuira Analytics Installation Guide.

InQuira Analytics Overview

InQuira Analytics processes InQuira application data to populate the reporting database 
and uses that data to generate a set of standard reports.

You create the data structure for the standard report, extract the log data and populate it to 
database using the processes described in Chapter 2, Configuring an Analytics 
Processing Task.

The standard reports use application-specific data dimensions, such as products, services, 
business units, and types of end-user questions that you define for your specific business 
environment.

You define the dimensions, such as products and question types, that you want to report on 
using the InQuira Analytics Administration interface, as described in Defining Analytics 
Hierarchies in the InQuira Analytics Installation Guide.
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You can then view, filter, manipulate, print, and export reports using the web-based 
InQuira Analytics user interface, as described in Chapter 4, Utilizing InQuira Analytics 
Reports

IMPORTANT:  See the InQuira Analytics Installation Guide for information on InQuira 
Analytics prerequisites and dependencies.

InQuira Analytics Architecture

An InQuira Analytics application consists of multiple components configured using one or 
more deployed InQuira instances. The InQuira Analytics components include:

• The data warehouse that stores the InQuira log data, the reporting hierarchy, and 
additional metadata used to create the reports.

• An InQuira instance configured to perform the data extraction and load (ETL) process.

• The InQuira Analytics report server, which hosts the report creation and user interface 
functions.

See InQuira Analytics Components on page 10 and The InQuira Analytics Reporting 
Process on page 12 for more information.

InQuira Analytics Components

InQuira Analytics uses the following components to import data from InQuira application 
log files, populate the reporting databases, and create the standard reports:

Data Warehouse Component:
Normalized reporting 
(ODS) database

The reporting database stores data extracted from the InQuira 
logs and acts as a staging environment for analytics data. This 
database stores the InQuira log, security and report information 
in relational form.
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InQuira Analytics Third-Party Components

InQuira Analytics uses an underlying third-party product, MicroStrategy, to create and 
present reports on which the Report Builder and Web-based user interface are based. The 
MicroStrategy components are installed and configured as part of the installation process 
described in the InQuira Analytics Installation Guide.

NOTE:  No special knowledge of MicroStrategy products is required to install or operate 
InQuira Analytics.

InQuira Analytics Server Components:
Report Builder The report builder is configured to build the standard InQuira 

Analytics reports that provide information on customer (end-
user) behavior, content utilization, user experience, and system 
usage and performance. You can also define and save custom 
reports using the features of the InQuira Analytics user 
interface.

Web-based user 
interface

The InQuira Analytics user interface displays easily readable 
standard reports and provides a complete set of tools for 
exploring, displaying, formatting, exporting, and printing 
reports, as well as customizing existing reports and creating 
custom reports for your organization.
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The InQuira Analytics Reporting Process

The InQuira Analytics reporting process consists of the following steps:

• The InQuira production instances produce logs that contain the user questions, 
application responses, and other user interaction information, such as user session ID

• The InQuira Analytics ETL server instance executes tasks to:

- Extract the log files from configured production instances

- Load them into the reporting (ODS) database

• The InQuira Analytics report server instance executes tasks to build and cache the 
defined reports

• InQuira Analytics users log on to view and manipulate the reports
12 Using InQuira Analytics



Chapter 2 Configuring an Analytics Processing Task

After you install InQuira Analytics and configure MicroStrategy you must set up an 
Analytics Processing task to make use of the collected data by the Analytics reports.

This section describes the process of Extracting, Loading, and Transforming (ETL) data 
for InQuira Analytics and how to configure an Analytics Processing task to complete this 
process. 

The InQuira Analytics ETL Process

You populate the reporting (ODS) database with log data from both the Intelligent Search 
and Information Manager configured production instances. You populate the reporting 
database by:

• Extracting log data from both configured production instances 

• Loading both the Intelligent Search and Information Manager data into the normalized 
reporting (ODS) database 

• Transforming the Normalized Intelligent Search and Information Manager Report 
Data to the Star Schema 
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The ETL Process does the following:

Extracts files from: 

<Inquira root>\InfoManager\logs\IMADMIN\audit\content
<Inquira root>\InfoManager\logs\<repository_name>\audit\user

and copies them to:

<Inquira root>\analytics\im\ETL\logs

Extracts files from:

<Inquira root>\instances\<content/runtime>\development\runtime\data\log\binary\<runtime 
instance>\

and copies them to:

<Inquira root>\instances\<instance folder>\content\data\analytics\logs

The ETL process then transforms and loads these files to the Report Database. After 
InQuira Analytics makes use of the data, the files are moved to:

<Inquira root>\analytics\im\ETL\archive
<Inquira root>\instances\<instance folder>\content\data\analytics\archive

and deleted from:

<Inquira root>\analytics\im\ETL\logs
<Inquira root>\instances\<instance folder>\content\data\analytics\logs

Executing the Intelligent Search and Information 
Manager Production Log Extraction, Load, and 
Transfer (ETL) Task

You can configure and execute the log extraction, load and transfer (ETL) task within 
System Manager. 

IMPORTANT:  Log extraction and synchronization tasks cannot access a runtime instance at 
the same time. The log extraction will fail with a null point exception 
because the synchronization task shuts down the services used by the log 
extraction task.

To execute the ETL task:

• Defining InQuira Analytics ETL Job on page 15 

• Running InQuira Analytics ETL Job on page 19
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Defining InQuira Analytics ETL Job

To define a new Job:

• Open System Manager

• Select the New...option on the Job List

The System Manager displays the New Job dialog:

• Select the Analytics Processing Job type

• Select Continue > to continue the job definition process.
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Define InQuira Analytics ETL Job

• Enter text into the Job Name field (such as, AnalyticsETL)

• Select Valid Environments: Production

• Select Check all available boxes (default)

InQuira provides the following tasks for managing InQuira Analytics data:

Task Description
Log Extraction Use this task to copy log data to the data/load directory (or the 

directory specified in the InQuira Analytics configuration) on this 
instance.

Pre-Log Loading Use this task to refer to a custom task specific to your application 
that should be performed prior to log loading.

Information 
Manager Log 
Extraction

Use this task to copy Information Manager log data to the data/
load directory (or the directory specified in the InQuira 
Analytics configuration) on this instance.

Intelligent Search 
Log Load

Use this task to download only the Intelligent Search log files 
from the production servers to the InQuira Analytics server.
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• Select Next >

Schedule Run Times

• Select how often you would like to run the Analytics ETL Task. (Select On Demand 
to run task immediately for verification purposes)

For more information see Scheduling a Job

• Select Next> 

Information 
Manager Log Load

Use this task to download only the Information Manager log files 
from the production servers to the InQuira Analytics server.

Information 
Manager 
Transform

Use this task to populate and transform data from Information 
Manager Analytics ODS Schema to Star Schema

PostAnalytics Use this task to refer to a custom task specific to your application 
that should be performed after the ETL process
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Configure Notifications

• Configure who will be notified of job processing events. For more information see 
Specifying Job Notification 

• Select Save

Your newly created job appears on the Job list.
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ved 

opped
Running InQuira Analytics ETL Job

To start your Analytics Processing Task:

To start a configured job interactively from the Job List in System Manager

• Select the job from the Job List

• Select More Actions, click Start Job Now...

The Start Job dialog displays:

• Select an option from the Start Job dialog display

Start Job now Submit the selected job for immediate processing using its currently sa
configuration

Temporarily 
modify job before 
starting

Modify the job configuration only for a single occurrence

Continue Job 
Processing

Continue a manually stopped job from the point at which processing st

Restart From 
Failure

Restart a failed job from the point of failure
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NOTE:  The System Manager includes interactive job information in the job history details, 
even when the job configuration is temporarily modified.

• Select Continue >

The view displays the Job Status screen.

Additional Configuration Procedures

This section describes how to configure Intelligent Search and Information Manager 
instances to supply log data to the InQuira Analytics application.

Managing InQuira Analytics User Accounts
You can create, modify, and delete InQuira Analytics users using the user MicroStrategy 
Desktop application that is installed on the InQuira Analytics server.

NOTE:  The Information Manager Analytics server is the processor on which you have 
installed the MicroStrategy application as described in the InQuira Analytics 
Installation Guide.

You access the MicroStrategy Desktop application as described in Accessing the User 
Management Facility on page 21

NOTE:  You must have administrator privileges to create, modify, and delete users.
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Accessing the User Management Facility
To access the User Management facility, log onto the MicroStrategy Desktop application.

• Select Start > All Programs > MicroStrategy > Desktop > Desktop on the InQuira 
Analytics server

The MicroStrategy Desktop application displays the login dialog:

• Log onto the Desktop application as an administrator

The Desktop displays the Inquira folder:
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Adding and Modifying Users
To add InQuira Analytics users:

• Expand the Administration node of the Inquira folder

• Expand the User Manager node of the Administration folder

• Select the Everyone node of the User Manager folder

The right pane of the Desktop window displays the currently defined users.

NOTE:  You can copy an existing user by right-clicking and selecting Duplicate from the 
drop-down menu. You can then right-click and select Grant access to projects to 
modify the new user's definitions and privileges.

• Right-click in the defined users pane, and select New.

• Select User.
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The User Editor dialog displays.
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• Use the following tabs of the user editor to specify new or modified user data and 
security roles:

Editor Tab Description
General Specify appropriate user login and password information.
Project Access Specify appropriate roles and privileges for the user. Each role 

comprises a group of privileges that you can grant or deny. 
Select each role that specifies an appropriate privilege, and 
deny access to any inappropriate privileges for the new user.

For example, you might create a user having all the privileges 
contained in the Web Reporter and Web Analyst role, but only 
a few of the privileges associated with the Desktop Analyst 
role.
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Deleting Users
To delete InQuira Analytics users:

• Expand the Administration node of the Inquira folder

• Expand the User Manager node of the Administration folder

• Select the Everyone node of the User Manager folder

The right pane of the Desktop window displays the currently defined users.

• Right-click on the desired user.

• Select Delete from the drop-down menu.
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Configuring Logging on Production Instances
You must configure the production instances that supply log data to InQuira Analytics to 
ensure that:

• The Intelligent Search and Information Manager instances are properly defined to the 
Intelligent Search scheduling instance

• The logs created by configured Intelligent Search instances:

• Are correctly formatted and contain the appropriate level of detail as described in 
Specifying Runtime Log Characteristics on page 26

• (Optional) Include data about end-user click-thru behavior as described in 
Specifying Click-thru Tracking on page 27

Specifying Runtime Log Characteristics
You must specify the correct log format and level of detail in the production server 
configuration. You specify the log characteristics using the Log page in the Instances 
section of the Advanced Configuration Facility. 

You specify the following parameters to generate logs having the proper format and level 
of detail:

Parameter Description Required/Optional/Default
Log Directory Specifies the directory in which 

the application will write its log 
files.

This is a required parameter. The 
default location is data/logs, 
which corresponds to the following 
location in the default instance 
(bootstrap) configuration: 
inquira_home/application 
/data/logs.
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 Configuring Intelligent Search Reporting Features
You can configure the following additional Intelligent Search reporting features using the 
Advanced Configuration Facility:

• record the answers that users select from the results page as described in Specifying 
Click-thru Tracking on page 27

• edit the labels in the User Feedback report to conform to those within your application 
as described in Updating Labels for the User Feedback Report on page 29

Specifying Click-thru Tracking
You can configure the application to record which answers on the results page end-users 
clicked-thru to view the source document. Click-thrus are included as a dimension on the 
Most Used Content and Least Content reports. 

NOTE:  Click-thru tracking is not available for links within embedded managed answers. 
See Rules in the Intelligent Search Language Tuning Guide for more information 
on embedded managed answers.

Queue Size Specifies the size of the 
queue, which determines 
the number of messages 
that will accumulate 
between write actions.

This is a required parameter. The 
default value is 1024.

Verbosity Specifies the level of detail of 
the logged application data. 
Higher levels of detail result in 
more resource and storage use.

This is a required parameter. The 
default is Analytics. You must set 
the log level to Analytics or higher to 
generate InQuira Analytics report 
data.

Listeners Specifies one of more log 
listeners for the application. 
Log listeners are 
components that handle log 
information from the Log 
Service in specified ways.

This is a required parameter. You 
must specify a Binary log listener to 
produce loadable log files from 
which to generate InQuira Analytics 
report data.
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When click-thru tracking is enabled, InQuira records:

• the session ID

• the answer ID

• the answer URL and anchor

for each click-thru, as well as for click-thrus on similar answers.

You configure click-thru tracking on all production instances for which you want to report 
on end-user click-thru behavior. Click-thru configuration is available on the Click-thru 
page of the Advanced Configuration Facility.

To configure click-thru tracking:

• select Click-thru from the Advanced Configuration Facility menu

The Click-thru page displays the Perform Click-thru Tracking field.

• select On in the Perform Click-thru Tracking field

Configuring Click-Thru Tracking for Managed Answers
You can configure click-thru tracking for links within the individual Dictionary rules that 
specify custom content managed answers. You configure click-thru tracking using a 
custom tag within the hypertext link specified in the custom content area of the managed 
answer rule. 

<link href="URL">link text</link>

where:

 The following custom text within a managed answer rule:

Answer Title<br> 
Click the link to learn more: 
<a href="http://www.somewhere.com/index.html">Click Here!</a> 

To convert the link to be tracked by InQuira Analytics, specify the <link> tag:

Answer Title<br> 
Click the link to learn more: 
<link href="http://www.somewhere.com/index.html">Click Here!</link> 

<link Specifies the beginning of the link tag
href Is the HTML standard hypertext link reference
"URL" Is the fully qualified URL for the answer source document, 

enclosed within double quotes
link text Specifies the text to display as the hypertext link
</link> Specifies the end of the link tag
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Updating Labels for the User Feedback Report
You can change the label text associated with the various user feedback levels used to rate 
answer quality in the User Interface. The labels displayed in the User Interface are 
configurable; however, they are independent of the labels that are displayed in the User 
Feedback Report. To maintain consistency, you must manually update both sets of labels.

See the Intelligent Search User Interface Guide for more information on editing the 
following default user feedback labels in the User Interface.

Level Default Label
0 No Feedback
1 Not Even Close
2 Hardly
3 Sure
4 Usually
5 Absolutely
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Chapter 3 Getting Started with InQuira Analytics

This chapter introduces the basics of utilizing InQuira Analytics reports, and guides you 
through the process of:

• Logging onto the InQuira Analytics application

• Navigating from the home page to any of the standard reports

• Drilling down to the analysis and details reports

• Logging out of InQuira Analytics

For information on InQuira Analytics report features see Chapter 4, Utilizing InQuira 
Analytics Reports.

Accessing InQuira Analytics Reports

After you have finished installing InQuira Analytics and configuring MicroStrategy you 
may access InQuira Analytics reports:

From the sever's Start menu:

Start->Programs->Microstrategy->Web

or direct a browser to:

http://<reportservername>/Microstrategy/asp/Main.aspx
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The following screen displays:

• Select the Web Administrator link.

The following screen displays:

• Enter the name of server and select Add.

• Select Save in the page that displays.

The server name will now display upon entering the site.
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• Select Connect next to the server name.

• Select Return to: MicroStrategy Web Home

The InQuira Analytics home page displays.

InQuira Analytics Home Page

The InQuira Analytics home page displays project folders for the installed InQuira 
business intelligence products:

• Select the Analytics Report Project folder to run reports from 

Project Folder Description
InQuira Search 
Analytics

This folder contains the InQuira Analytics standard, analysis, 
and detail reports. 

InQuira Information 
Manager Analytics

This folder contains the Information Manager Analytics 
content usage standard reports.

InQuira Information 
Manager Operational 
Reports

This folder contains the Information Manager Analytics 
content management standard reports.
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• Enter your user ID and password

NOTE:  Consult your InQuira Analytics administrator for correct user name and password 
information if necessary.

InQuira Analytics displays the main page for the Analytics project folder you selected:

To access InQuira Analytics reports:

• Select the Shared Reports folder:

InQuira Analytics displays the standard report folders as described in The InQuira 
Analytics Shared Reports on page 46.

Viewing InQuira Analytics Reports

The InQuira Analytics Shared Reports folders contain the default configurations of the 
standard reports designed for use with InQuira applications.

To view an InQuira Analytics report:

• Select the report category folder that you are interested in.

• Select the desired report.

• Specify the report creation parameters (see Selecting Report Creation Parameters on 
page 35).

• Select Run Report.
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Selecting Report Creation Parameters

Each Analytics report has a slightly different set of associated report elements or 
parameters. The settings you choose on the Report Parameters page prior to running the 
report determines the context for the data within the report. 

To select report elements:

• For long lists of elements, use the Search function to limit the list in the Available 
column

• Using the selectors, move the report element(s) to the Selected column. 

NOTE:  The report criteria that you select is carried forward as the reporting context for the 
Analysis and Detail reports that you drill down to from the resulting report.

• Continue selecting other report creation parameters.

For a complete list of report parameters available for each InQuira Analytics product refer 
to Intelligent Search Analytics Report Creation Parameters on page 35, Information 
Manager Analytics Report Creation Parameters on page 37, or Operational Report 
Creation Parameters on page 37.

Intelligent Search Analytics Report Creation Parameters
You generate the InQuira Analytics reports by specifying report creation parameters to 
restrict the data against which the report is run. For information on how to use the report 
parameters page, refer to Selecting Report Criteria. 

The following parameters are available:

Parameter Description
User Segment Lets you look at data based on one or more groups of users
Language Selects data only for specified languages
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Query Source Specifies the source (Web, for example) of the activities 
reported on. Only the following activity types have a query 
source: 

• Basic Search

• Process Wizard Complete and Search

• Escalation Attempt
Child activities are the activities that follow the parent 
activities, the parent activity types include:

• Basic Search 

• Process Wizard Complete and Search 

• Escalation Attempt

• Facet Selection Search 
Activity Type Specifies the type of interaction with the application user 

interface to report on. The activity types are: 

• Basic Search

• Facet Selection Search

• Process Wizard Invocation

• Process Wizard Stepping

• Process Wizard Completion

• Process Wizard Completion and Search

• Click-thru

• Rating Question

• User Feedback

• Escalation Completed

• Escalation Deflected

• Escalation Attempt

• Escalation No Answer and Completed

• Paging

• Session Started
Cluster Selects data based on specific question clusters
Concept Restricts report data to specific concepts or products
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Information Manager Analytics Report Creation Parameters
You generate the Information Manager Analytics reports by specifying report creation 
parameters to define:

• The weeks that you want to include in the report

• Thresholds, such as the rating level for the Content Feedback and Forum Feedback 
reports, and the number of times accessed for the Content Usage reports

For information on how to use the report parameters page, refer to Selecting Report 
Creation Parameters on page 35 in the InQuira Analytics User's Guide. 

The following parameters are available:

Operational Report Creation Parameters
You generate the operational reports by specifying report creation parameters to define:

• The beginning and end dates that you want to include in the report

• Date ranges

• Time ranges to categorize the report data

See:

• Specifying Content Aging Parameters on page 239

Intent Restricts data to selected intents
Top/Bottom Restricts data by maximum or minimum values
Portlet Restricts data by portlet

Parameter Description
Reporting Weeks Select the weeks for which you want to include data.
First Week Select or enter a date in the first week for which you want 

to include data.
Last Week Select or enter a date in the last week for which you want 

to include data.
Rating Threshold Specify a value within the range of your application's 

rating system to create reporting categories.

For example, for a rating system range of 1-10 you could 
specify a threshold of 5 to determine the number of records 
having an average rating above and below the median.

Access Count Threshold Specify a value within the range of you application's rating 
system to create reporting categories.
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• Specifying Content Due to Expire Parameters on page 242

• Specifying Content in Process Parameters on page 248 

• Specifying Published Content Parameters on page 251

for detailed information on the required and optional parameters for each operational 
report.
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Drilling Down to More Detailed Data

You can view more detailed information for a report by "drilling down" to view data for:

• Different time segments, as described in Drilling Down to View Different Time 
Segments on page 39

• Report details from a Detail or Analysis report, as described in Drilling Down to View 
Analysis and Detail Reports on page 40.

Drilling down:

• Restricts the scope of the report display to the selected element

• Provides detailed information on the component elements

while retaining any filters or other contexts imposed by the originating report. 

Drilling Down to View Different Time Segments

You can view data in different time segments by drilling down (or up) to select another 
time view. 

• Right-click on the row in the Time column to display the drill-down menu

• Select an option.

The report now displays detailed data for the time increment selected.
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Drilling Down to View Analysis and Detail Reports

You can drill down to view Analysis and Detail reports from all of the standard reports, 
and other Analysis and Detail reports from most of the Analysis and Detail reports.

NOTE:  When you drill down, Analysis and Detail reports carry forward the context of the 
originating report including the report criteria you selected when you ran the 
report, and any prompts or filters you applied afterwards.

To drill down:

• Right-click on the Analysis column to display the drill-down menu

Each report will display a variety of drill down analysis options.

Intelligent Search Analytics Analysis Reports
Intelligent Search Analytics Analysis reports provide session-level analysis of data that 
you drill down to from an Intelligent Search Analytics standard report.

NOTE:  Analysis reports are available only by drilling down from a standard report. They 
are not available as stand-alone reports.

Analysis reports include:

• Click-thru and Response Time Analysis Report – which shows session response and 
click through statistics

• Intent/Concept Analysis Report – which shows how well intents and concepts are 
aligned with the questions users are asking

• Session Navigation Analysis Report – which shows how often users click a facet or a 
process wizard is invoked

• User Feedback Analysis Report – which shows user ratings and comments for the 
responses returned for a question
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Intelligent Search Analytics Detail Reports

Detail Reports provide a very specific view of activity-level data that you drill down to from 
Analysis reports or from other Detail reports.

NOTE:  Detail reports are available only by drilling down from a standard report, an 
analysis report, or from another detail report. They are not available as stand-alone 
reports.

Intelligent Search Analytics detail reports include:

• Intent Details Report – which shows how often activities helped deflect user questions

• Question Response Details Report – which shows how responses are used in the 
system

• Question Details Report – which shows the normalized questions for the current 
context

• Rating Details Report – which shows user ratings and comments for specific questions

• Concept Details Report – which shows the session details for a concept

• Words without Concepts Details Report – which shows details for a word not 
recognized by the system

• Intent Response Details Report – which shows how well responses are working on 
your site

• User Activity Details Report – which shows how people are using activities

• Process Wizard Details Report – which shows the process wizards that are being used 
most

Drilling to Information Manager Analytics Detail Reports

You can drill within Information Manager Analytics reports to display more detailed 
information. Available information typically includes data grouped by:

• Day, Month, Year, and Quarter

• Content channel

• Content owner

• Original author

In addition, you can drill down to view detailed information at the individual content 
record level, as described in Drilling to Information Manager Analytics Content Record-
level Details on page 42.
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To drill to detail reports:

• Right-click the row of the report grid for which you want to view details

Information Manager Analytics displays the drill menu:

• Select the drill option

Information Manager Analytics displays the detail report.

Drilling to Information Manager Analytics Content Record-level Details
You can drill down to view detailed information for each content record included in the 
report. Information Manager Analytics provides the following content record-level detail 
reports:

 To drill to content record-level detail reports:

• Right-click in any row of the report grid

Information Manager Analytics displays the drill menu:

• Select the detail report option

Information Manager Analytics displays the content record-level detail report.

Detail Report Description
Rated Content Details Report 
on page 206

This report displays detailed information for the content 
records that contribute to the Content Feedback report.

Accessed Content Details 
Report on page 210

This report displays detailed information for the content 
records that contribute to the Content Usage reports.

Most Popular Content 
Details Report on page 213 

This report displays detailed information for the content 
records that contribute to the Most Popular Content 
report.

Published Content Details 
Report on page 217

This report displays detailed information for the content 
records that contribute to the Published Content report.
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Drilling to Content Record-level Operational Details

You can drill down to view detailed information for each content record included in the 
operational report. Information Manager Analytics provides the following content record-
level detail reports:

To drill to content record-level detail reports:

• Right-click in the first column of any row of the report grid

Information Manager Analytics displays the drill menu:

• Select the detail report option

Information Manager Analytics displays the content record-level detail report.

Detail Report Description
Content Aging Details This report displays detailed information for the content 

records that contribute to the Content Aging report.
Content Due to Expire Details This report displays detailed information for the content 

records that contribute to the Content Expiration reports.
Content in Process Details This report displays detailed information for the content 

records that contribute to the Content in Process report.
Published Content Details This report displays detailed information for the content 

records that contribute to the Published Content report.
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Logging Out of InQuira Analytics

You can end your InQuira Analytics session by logging out of the application. We 
recommend that you explicitly log out of your sessions rather than simply closing the 
browser window.

NOTE:  InQuira Analytics terminates any sessions that have been idle for more than ten 
minutes.

• Select the Logout link in the upper right portion of the InQuira Analytics display:

The logout message displays:

The logout process is complete.
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Chapter 4 Utilizing InQuira Analytics Reports

This section contains the following information: 

• The InQuira Analytics Shared Reports on page 46

• Setting InQuira Analytics Preferences on page 47

• Changing InQuira Analytics Report Displays on page 71

• Specifying Background Report Creation and Caching on page 88

• Saving Reports for Deferred Actions on page 89

• Exporting Reports to PDF Format on page 92

• Exporting Reports on page 94

• Printing Reports on page 96
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The InQuira Analytics Shared Reports

The InQuira Analytics Shared Reports page displays the InQuira Analytics report category 
folders, as described in Report Types.

It also displays other elements of the user interface, including:

• Application tabs, as described in Application Tabs on page 46

• The navigation path links (also known as "breadcrumbs"):

• The LOGOUT link, as described in Logging Out of InQuira Analytics on page 44.

Application Tabs

The application tabs display at the top of the InQuira Analytics user interface:

Each tab provides access to a specific application function as described in the following 
table:

Application Tab Description
Shared Reports The Shared Reports tab is the default display that contains the 

InQuira Analytics built-in report categories.
My Reports This tab provides a private folder for any edited or custom 

reports that you save.
Create Report This tab displays the custom report creation tools as described 

in the Intelligent Search Analytics Reference.
Create Document This tab displays the document creation tools as described in 

the Intelligent Search Analytics Reference.
My Subscriptions This tab displays the reports to which you have subscribed as 

described in Specifying Background Report Creation and 
Caching on page 88.

History List This tab displays the reports that you have added to the 
History List as described in Saving Reports for Deferred 
Actions on page 89.
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Setting InQuira Analytics Preferences

You can set preferences for InQuira Analytics display, print, export, and other facilities 
using the Preferences tab of the InQuira Analytics user interface:

You can set preferences at the following levels:

Preferences This tab accesses the display settings for the user interface. 
You can set individual user preferences, or, if you are an 
administrator, set default preferences for all users. You can 
apply your preferences to the current application, or to all 
applications residing on the server. See Setting InQuira 
Analytics Preferences on page 47 for more information on 
setting user preferences.

Preference Level Description
InQuira Analytics 
application (project) 
defaults

Project default preferences apply to all application users, 
but individual users with appropriate privileges can 
override the defaults.

You must have administrator privileges to set project 
default preferences.

Individual user 
preferences

User preferences apply to all sessions that you log onto 
with your individual user ID
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Setting Project Preferences

You can set project preferences, which set defaults for the entire InQuira Analytics 
application, using the Project defaults settings in the Preference tab.

To access project preferences:

• Select the Preferences option from the navigation options.

The Preferences page displays the General user preference settings.

• Select Project Defaults from the Preferences Level menu.

The Preferences page displays the General project default settings.

You can set project preferences for a wide variety of InQuira Analytics functions, 
including:

• General preferences, such as default start page, as described in Setting General 
Project Preferences on page 49

• Report folder display and browsing behavior as described in Setting Project Folder 
Browsing Preferences on page 51

• Grid and graph display preferences as described in Setting Project Grid Display 
Preferences on page 52 and Setting Project Graph Display Preferences on page 54

• History list preferences as described in Setting Project History List Preferences on 
page 55

• Export and PDF preferences as described in Setting Project Export Preferences on 
page 56 and Setting Project PDF Print Preferences on page 59

• Preferences for drilling to detailed data as described in Setting Project Data Drilling 
Preferences on page 61 

• Security preferences as described in Setting Project Security Preferences on page 63

You can also specify the project password as described in Changing the Project 
Password on page 64.
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Setting General Project Preferences
The General preferences page contains the following settings:

Preference Description
Default start page Use this field to select a default start page for the application.
Locale This field sets the language, number and date format, and time 

zone of the Information Manager Analytics application; we 
recommend that you use the default settings.

Dynamic HTML These settings enable DHTML to enable:

• drag and drop functionality

• right-click menu options

• drop-down menus

• automatic submission of selections on pull-down lists in 
a variety of places in the interface

within browsers that support DHTML; we recommend that you 
use the default settings, which automatically enable support in 
compatible browsers.

Accessibility mode Use this setting to enable screen reader compatibility if you use 
software that audibly reads what is on the page.
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Drop down menus Use this setting to determine whether to require a mouse click 
to open menu items or open them in response to a mouse-over. 
This setting applies only when DHTML is active.

Data display Use this setting to delete extraneous white space from displays 
of warehouse element data.

Search Use this field to set the maximum number of elements in a 
search string, and the maximum number of concurrent searches 
that the application can conduct.

Refresh report Use this field to set the application to:

• retrieve report data from cache

• execute the report from the data warehouse
when users select and refresh reports.

Incremental fetch Use this field to specify the maximum number of attribute 
elements and report objects to include in a block of data; we 
recommend that you use the default settings.

Wait page Use this field to set the time in seconds before page refresh.
Administrator contact Use this field to specify contact information for an 

administrator.
Font style Use these settings to specify fonts for the application; we 

recommend that you use the default settings.

You specify fonts to apply to the interface and reports in a 
priority order. Once you select a font in the Available column, 
click the right arrow to move it to the Selected column. You can 
then select a font and click the up or down arrows to order them 
in the priority to use on reports. You can also set the Font size 
to the value you need.

Output Formats Specify whether to print reports as PDF documents, and 
whether to re-use a single window or open multiple windows 
for multiple export and print actions.

OLAP Services 
Reports

Specify whether allow overwriting of existing reports with 
MicroStrategy 8 OLAP Service reports, and whether to issue a 
warning when the action occurs.

Cart-style selections Specify whether to retain items in a list of available answers 
when selecting from cart-style prompts or filters.
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Setting Project Folder Browsing Preferences
The Folder browsing preferences page contains the following settings:

Preference Description
Shared Reports 
Folder

This field sets the location of the Shared Reports Folder; we 
recommend that you use the default settings.

My Reports Use this setting to hide the My Reports link from users who do 
not have permission to save reports.

Folder Browsing Specify whether to enable a persistent filter and template when 
navigating within the report folders.
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Setting Project Grid Display Preferences
You can specify the following project default settings for grid displays:
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Preference Description
Grid style Use this setting to specify:

• The grid style preference stored in the report 
definition

• A selected default grid style
If you choose to use a selected grid style, you cannot make 
formatting changes to any of the reports; we recommend that 
you use the default setting.

Default grid style Use this setting to select a default grid style for all reports; 
we recommend that you use the default setting.

Maximum rows in grid Use this setting to specify the maximum number of rows in a 
report. If your report has more rows than the value entered 
here, you can use the incremental fetch links to view more 
data.

Maximum columns in 
grid

Use this setting to specify the maximum number of rows in a 
report. If your report has more columns than the value 
entered here, you can use the incremental fetch links to view 
more data.

Show attribute form 
names

Use this setting to select whether attribute form names for 
attributes with multiple forms are displayed in reports.

Show pivot buttons Specify to display the pivot buttons to change column 
positions in displays.

Show sort buttons Specify to display the pivot buttons to change row positions 
in displays.

Enable sorting by 
attribute forms

Specify to allow sorting by report attributes that are not 
included in the display

Automatic page-by Use this setting to determine whether a new page of 
information displays immediately when you select a choice 
in a page-by drop-down list (if DHTML is enabled).

If this setting is disabled, you must click the apply icon to see 
the new information after making a selection.

Use images for depicting 
expand and contract in 
outline mode

Specify to include the expand and contract images in outline 
mode.
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Setting Project Graph Display Preferences
You can specify the following project default settings for graph displays:

Allow word-wrapping of 
row headers in the 
report grid

Specify to allow word wrapping of row headers.

Allow word-wrapping of 
metric values in the 
report grid

Specify to allow word wrapping of metric values.

Show object descriptions 
as tooltips in grid

Specify to display object descriptions within text boxes when 
hovering the mouse over an object.

Default width for row 
axis columns

Specify the default row width.

Default width for data 
columns

Specify the default data column width.

Preference Description
Graph size Use this setting to:

• use the size settings stored in the report definition
or

• manually set the size (width and height) of report 
graphs
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Setting Project History List Preferences
You can specify the following project default settings for History Lists:

Image format Use this setting to:

• manually set the image format (jpeg or gif) of report 
graphs

or

• use the format settings stored in the report definition
Show graph reports Use this setting to specify whether graph reports display by 

default when users select Grid and Graph view mode.

Preference Description
Add reports and 
documents to my 
History List

Use this setting to specify whether to automatically or 
manually add reports to the History List.

Keep recent reports 
and documents

Use this setting to set the number of reports that will be 
maintained in the History List.

Results of scheduled 
reports

Use this setting to specify whether new reports will 
overwrite older versions in the History List.

Keep Document 
available

Specify to retain the document when printing or exporting.
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Setting Project Export Preferences
You can specify the following project default settings for exporting reports:
56 Using InQuira Analytics



Preference Description
Export: Whole report/
Portion displayed

Use this setting to export either the entire report, or only the 
portion of the report displayed in your browser.

Export grids tot Use this setting to export grid data:

• Excel as plain text

• comma separated text file

• Excel while maintain all report colors, fonts and 
structure

• HTML

• Plain text using the specified delimiter to separate 
each cell of the report

Export graphs to Use this setting to export graph data to:

• Excel as plain text

• comma separated text file

• Excel while maintaining all report colors, fonts and 
structure

• HTML

• Plain text using the specified delimiter to separate 
each cell of the report

Export HTML 
documents to

Use this setting to export HTML documents to:

• HTML while maintaining format, color, and 
structure and features

• Excel in plain text, giving users access to the raw 
data of the grid reports

Graph reports within documents are not exported to Excel.
Maximum number of 
cells to export

Specify the maximum number of report cells to export for 
plain text and HTML.
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Export metric values as 
text

Use this setting to specify that numeric values will be 
exported as text or as numbers.

If you choose to export as numbers, Excel may 
automatically format the number. For example, $34.23614 
may be rounded to $34.24 in Excel. If you choose to export 
metric values as text, Excel does not automatically format 
the numbers.

Excel version Specify the version to use for exports to Excel.
Export metric values as 
text

Specify to convert metric values to text when exporting to 
Excel.

Export headers as text Specify to convert header values to text when exporting to 
Excel.

Export filter details Use this setting to export the filter details on any given 
report. If you choose to export them, they display right 
above the exported report.

Export graphs as live 
charts

Specify to export graphs as editable objects when exporting 
to Excel with formatting.

Remove extra column 
from exported grid

Specify to remove extra columns.

Show options when 
exporting

Use this setting to open the Export Options page each time 
you export a report. If you clear the check box, the options 
page does not display and the report exports with the settings 
you have saved in User Preferences.
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Setting Project PDF Print Preferences
You can specify the following project default settings for printing reports as PDF 
documents:
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Preference Description
Export Use this setting to specify whether to export the entire report 

or the portion displayed.
Header and Footer Use this setting to specify to use the settings specified in the 

report or to use custom settings on all reports when exporting 
to PDF. Use the Edit Custom Settings link to define custom 
headers and footers.

Scaling Use this setting to specify whether the report's content size 
will be adjusted by default to:

• A specified percentage of the original size

• Specified page dimensions
Orientation Use this setting to specify whether reports are exported to PDF 

in landscape (horizontal) or portrait (vertical) orientation.
Print cover page with 
filter details

Specify to print a separate cover page containing the filter 
settings used.

Expand page-by fields Specify to expand all collapsed page-by fields in the 
document.

Paper size Use this setting to specify the paper size on which to export a 
report.

Margins (inches) Use this setting to specify the top, left, right, and bottom 
margins. For reports to print correctly, these margin settings 
must match those in the browser's File, Page Setup option. The 
default value for all margins is 0.75 inches.

Maximum header/
footer size (inches)

Use this setting to specify the size at which the report header 
and footer can be overwritten.

If the header or footer is larger than its maximum size and the 
report must use the space to display its content, the header or 
footer is cut off by the report content. If the report does not use 
the space, the entire header or footer displays regardless of 
size. The default value for each is 5 inches.

Use bitmaps for 
graphs

Specify to print graphs using bitmaps.

Embedded fonts Specify to use embedded fonts within the PDF.
Project Header and 
Footer

Specify project information to include in the document header 
and footer.
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Setting Project Data Drilling Preferences
You can specify the following project default settings for drilling to more detailed data:

Show options when 
exporting to PDF

Use this setting to specify whether the PDF Options page will 
display each time a report is exported to PDF.

Preference Description
Drill options Specify to:

• Use drilling options specified in the report definition

• Disable all drilling

• Allow drilling only with hyperlinks

• Allow simple drill

• Allow drill anywhere
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Enable context menu 
drilling

Use this setting to enable drilling using the right-click drill 
menu.

Display advanced drill 
options

Specify to provide access to advanced options as:

• Link to the advanced drill editor

• Sub menus on the context menu
Group drill options on 
the drill context menu 
according to the drill 
path type

Specify to group drill options by path type.

Sort drill paths and set 
names alphabetically

Specify to use alphabetical sorting for lists of drill paths.

Disable hyperlink 
drilling

Specify to disable drilling by selecting a hyperlink.

Enable drilling options 
on metric values

Use this setting to enable users to drill on metric values using 
the right-click drill menu or hypertext links.

Keep parent while 
drilling

Use this setting to specify whether to retain the parent object 
in the report when drilling down to view its children. This 
setting overrides the default behavior defined in each report.

Keep thresholds while 
drilling

Use this setting to override the default behavior defined in 
each report to retain or not retain the report thresholds when 
performing a drill action.

Open drill results in 
new window

Specify to open a new window for each drill action.
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Setting Project Security Preferences
You can specify the following default session security settings for InQuira Analytics:

Preference Description
Login Modes Specify one of the following modes for user authentication:

• Standard (user name and password)

• LDAP Authentication

• Database Authentication

• Guest

• Windows Authentication
Cancel this session's 
pending requests

Specify to cancel all pending jobs when a user logs out, and 
specify whether to make this option available in user 
preferences.
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Changing the Project Password
You can change the project password using the Change Password option of the 
Preferences menu:

Specify the existing password, the new password, and re-enter the new password to verify.

Remove the finished jobs 
from the History list

Specify whether to:

• Remove document and report messages from the 
History List at logout

• Remove only messages that have been read
Specify whether to make this option available in user 
preferences.
64 Using InQuira Analytics



Setting User Preferences
You can set user preferences, which apply only to the user ID under which they are set, 
using the User Preferences settings from the Preference menu.

To access user preferences:

• Select the Preferences menu

The Preferences page displays the General user preference settings.

You can set user preferences for the following InQuira Analytics functions:

• General preferences, such as default start page, as described in Setting General User 
Preferences on page 66.

• Grid and graph display preferences as described in Setting Project Grid Display 
Preferences on page 52 and Setting Project Graph Display Preferences on page 54.

• Print, export, and PDF preferences as described in  Setting Print User Preferences on 
page 68, Setting Project Export Preferences on page 56, and Setting Project PDF 
Print Preferences on page 59.

• Preferences for drilling to detailed data, as described in Setting Project Data Drilling 
Preferences on page 61.

• Logout preferences as described in Setting User Security Preferences on page 70.
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Setting General User Preferences
The General preferences page contains the following settings:
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Preference Description
Default start page Use this field to select a default start page for the application.
Locale This field sets the language, number and date format, and time 

zone of the InQuira Analytics application; we recommend that 
you use the default settings.

Dynamic HTML These settings enables DHTML, which provides:

• Drag and drop functionality

• Right-click menu options

• Drop-down menus

• Automatic submission of selections on pull-down lists 
in a variety of places in the interface

within browsers that support DHTML. We recommend that you 
use the default settings, which automatically enable support in 
compatible browsers.

Accessibility mode Use this setting to enable screen reader compatibility if you use 
software that audibly reads what is on the page.

Drop down menus Use this setting to determine whether to require a mouse click 
to open menu items or open them in response to a mouse-over. 
This setting applies only when DHTML is active.

Incremental fetch Use this field to specify the maximum number of attribute 
elements and report objects to include in a block of data; we 
recommend that you use the default settings.

Font style Use these settings to specify fonts for the application; we 
recommend that you use the default settings.

You specify fonts to apply to the interface and reports in a 
priority order. Once you select a font in the Available column, 
click the right arrow to move it to the Selected column. You can 
then select a font and click the up or down arrows to order them 
in the priority to use on reports. You can also set the Font size 
to the value you need.
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 Setting Print User Preferences
You can specify the following project default settings for printing reports:
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Preference Setting
Orientation Use this setting to select either portrait or landscape page 

orientation.
Paper size Use this setting to select the paper size for printed reports.
Header and Footer Use this setting to specify default headers and footers within 

report settings or to specify a customized header and footer on 
all reports. Use the Edit Custom Settings link to customize 
headers and footers.

Scaling Use this setting to adjust the amount of the report's content 
(and thus, the size of the font) that prints on a page. Select 
either to:

• Adjust the font as percent of original size

• Fit to page for all columns, all rows, or both
Margins (inches) Use this setting to set the top, left, right and bottom margins.

IMPORTANT:  These settings must match corresponding 
browser settings for reports to print 
correctly.

Maximum header/
footer size (inches)

Use this setting to set the size at which the report header and 
footer can be overwritten. If the header or footer is larger than 
its maximum size and the report must use the space to display 
its content, the header or footer is cut off by the report content. 
If the report does not use the space, the entire header or footer 
displays regardless of size.

Disable DHTML 
printing

Use this setting to turn off DHTML printing; HTML printing 
will be enabled.

Print cover page with 
filter details

Use this setting to print the filter details of the report on a 
separate page before the contents of the report. 

Open new window 
when printing

Use this setting to select whether to have the print preview in a 
new browser window or in the current window.
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Setting User Security Preferences
You can specify the following project default security settings for logging out of the 
application.

Print the grid and the 
graph on the same 
page

Use this setting to specify that the grid and the graph will be 
printed on the same page when printing a report displayed in 
Grid and Graph mode.

If you select the check box, the graph you are currently 
viewing will be placed on one page along with the 
corresponding grid. Additional sections of the report, if any, 
will be displayed on subsequent pages, always with the graph 
and its corresponding grid rows on the same page.

If you clear the check box, the grid and graph will print on 
separate pages.

Expand all page-by 
fields when printing

Use this setting to print all combinations of items in the Page-
by axis when printing a report that has one or more items in 
the Page-by axis. To print only the items currently displayed, 
clear this check box.

Show options when 
printing

Use this setting to specify to be prompted for print options 
every time you print.

Preference Description
Cancel this session's 
pending requests

Use this setting to specify to cancel all pending jobs associated 
with a user who is logging out, and whether or not to prompt 
the user with this choice.

Remove the finished 
jobs from the History 
list

Use this setting to remove document and report messages from 
the History List at logout. You can also be prompted for this 
option when you log out.
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Changing InQuira Analytics Report Displays

While you are viewing a report, you can use the following controls in the user interface to 
change the display, including:

• The report criteria, as described in Selecting Report Creation Parameters on page 35

• The time frame covered by the report, as described in Changing the Report Time 
Frame on page 77

• The graph or grid view, as described in Changing the Display View on page 72

• The order of the grid data rows, as described in Sorting Report Data on page 84

• The order of grid columns, as described in Moving Display Columns on page 86

• The columns included in the display, as described in Removing Columns from the 
Report Display on page 87

• The level of detail as described in Drilling Down to More Detailed Data on page 39

Function Icons

The Function Icons display in the upper right portion of each report, and provide quick 
access to frequently-used functions:

Icon Function Description
Design Mode Invokes Design Mode, which enables you to 

customize reports.
Grid Changes display to Grid only.

Graph Changes display to Graph only.

Grid and Graph Changes display to Grid and Graph

NOTE:  The Grid, Graph, and Grid and 
Graph icons toggle depending on the 
current display format.

Print Invokes the print options page, or automatically 
prints the current report, depending on the 
specified application defaults and your personal 
preference settings.
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Changing the Display View

Each standard report is configured to display as a graph, grid (table), or a graph and grid 
together. You can change the display using the View drop-down menu located below the 
report title.

To change the report display:

• Select the View drop-down menu

The View drop-down menu displays the available display options:

• Grid

• Graph

Export Invokes the export options page, or 
automatically prints the current report, 
depending on the specified application defaults 
and your personal preference settings.

PDF Invokes the export to PDF options page, or 
automatically prints the current report, 
depending on the specified application defaults 
and your personal preference settings.

You must have Adobe Acrobat installed locally 
to export reports to PDF.

Refresh Refreshes the report display.

Re-prompt Returns you to the report criteria page so that 
you can select new report criteria with which to 
re-run the report.

Save Saves the current report.
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• Grid and Graph

NOTE:  A check mark indicates the current display option.

• Select the desired display option

Viewing Current Report Filters

To view current report filters:

• Select Report Filter from the View menu:

The report displays the currently defined report filters:
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Filtering Intelligent Search Analytics Report Displays

You can filter Intelligent Search Analytics reports to display only data for a specific time 
period (such as 'week'), or for a specific system confidence level. To filter a report select 
the filter options from the PAGE-BY area above the data display:

You can apply the following filters:

Filter Option Description
Year Restricts report data to the specified year.
Quarter Restricts report data to the specified quarter for the selected 

year.
Month Restricts report data to the specified month for the selected 

quarter.
Week Restricts report data to the specified week for the selected 

month. 
Day Restricts report data to the specified day for the selected 

week.
Hour Restricts report data to the specified hour for the selected day.
Confidence Level Restricts report data to a specified system confidence level.
Response Type Restricts report data to the specified response type.
Activity Type Restricts report data to the specified activity type.
Session Restricts report data to the specified session.
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Filtering Information Manager Analytics Report Displays

You can filter Information Manager Analytics reports to display only data pertaining to a 
selected data set. You filter a report by selecting the desired filter option in the PAGE-BY 
area above the data display:

• Select the desired option to filter the report data by:

Filter Option Description
Repository Select any repository from the list of defined repositories for 

your Information Manager application.
View Select any view from the list of defined views, or select 

TOTAL to display data for all views. TOTAL is the default.
Category Select any category from the list of defined categories, or 

select TOTAL to display data for all categories. TOTAL is the 
default.

User Group Select any user group from the list of defined user groups, or 
select TOTAL to display data for all user groups. TOTAL is 
the default.

Team Select any work team from the list of defined teams, or select 
TOTAL to display data for all work teams. TOTAL is the 
default.

Channel Select any channel from the list of defined content channels, 
or select TOTAL to display data for all channels. TOTAL is 
the default.

Locale Select any locale from the list of defined locales (languages), 
or select TOTAL to display data for all locales. TOTAL is the 
default.

Week Select any week from the list of weeks available in the 
specified reporting period (beginning and ending dates). 
TOTAL is the default.

Discussion Board Select any discussion board from the list of available 
discussion boards, or select TOTAL to display data for all 
discussion boards. TOTAL is the default.

Forum Select any forum from the list of currently available forums, 
or select TOTAL to display data for all forums. TOTAL is the 
default.
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IMPORTANT:  The display filter options are ordered, and the filter for each option 
determines the available options for subsequent filters. If you set an option 
to TOTAL, the TOTAL option will be the only option available for the 
lower order filters (displayed to the right). 
          
For example, if you select the option TOTAL for the Channel filter, 
Information Manager Analytics automatically sets the Locale and Week 
filters to TOTAL.

Filtering Operational Report Displays

You can filter operational reports to display only data pertaining to a selected:

• Information Manager repository

• Channel

• content age, expiration, and days in process

• new or modified state

• Time Range

You filter a report by selecting the desired filter option in the PAGE-BY area above the 
data display:

• Select the desired option to filter the report data by:

Filter Option Description
Repository Select any repository from the list of defined repositories for 

your Information Manager application.
Channel Select any channel from the list of defined content channels, 

or select TOTAL to display data for all channels. TOTAL is 
the default.

Locale Select any locale from the list of defined locales (languages), 
or select TOTAL to display data for all locales. TOTAL is the 
default.

Week Select any week from the list of weeks available in the 
specified reporting period (beginning and ending dates as 
described in Information Manager Analytics Report 
Creation Parameters on page 37 TOTAL is the default.
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IMPORTANT:  The display filter options are ordered, and the filter for each option 
determines the available options for subsequent filters. If you set an option 
to TOTAL, the TOTAL option will be the only option available for the 
lower order filters (displayed to the right). 
               
For example, if you select the option TOTAL for the Channel filter, 
Information Manager Analytics automatically sets the Locale and Week 
filters to TOTAL.

Changing the Report Time Frame

The InQuira Analytics standard reports are individually configured to display data from a 
specific time frame.

You can change the time frame of a report by:

• Changing the value of a currently defined time interval.

For example, you can change the report to display data from the previous month instead 
of the current month, as described in Changing the Value of the Current Time Interval 
on page 78.

• Changing the time interval.

For example, you can change the report to display data from the current quarter instead 
of the current month, as described in Changing the Time Interval on page 81.

Report time frames are set within report filters in the report's default configuration, which 
you can view using the Report Filters option of the View menu, as described in Viewing 
Current Report Filters on page 73.
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Changing the Value of the Current Time Interval
You can change report time frames by editing the value of the currently defined time 
interval. 

To change the value of the current time interval:

• Select Design Mode from the View menu:

or from the Function icons:

The report displays in design mode, which displays the objects and attributes defined for 
the current report:

To edit the filter on the report, for example, to display data from the previous year:

• Select Edit Report Filter on the design mode page:
78 Using InQuira Analytics



The design mode page displays the current report filter:

To change the value of the time interval to the previous year:

• Right-click on Year in the Object Browser.

• Click on Add to Filter

The Report Filter displays the Year value selection fields.
• Select the Select option to display the available values for the Year interval:
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• Select the desired value using the selection arrows

• Use the checkmark  icon to complete your selection

The Year filter now displays the edited report filter value.

• Select Execute Report to create the report using data only from the previous year.

You can save the report to the My Reports folder, as described in Saving New and 
Modified Reports in the InQuira Analytics Reference Guide, where it will be available to 
you in future sessions. 
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Changing the Time Interval
You can change report time frames by re-defining the time interval. For example, you can 
configure a report to display data from the current quarter instead of the current year.

To change the value of the current time interval:

• Select Design Mode from the View menu:

or from the Function icons:

The Activity Usage report displays in design mode, which displays the objects and 
attributes defined for the current report:

To edit the filter on the report to display data from the previous week:

• Select Edit Report Filter on the design mode page:
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The design mode page displays the current report filter:

The current report filter sets the time interval for data collection. The current filter 
specifies the Time Year and the Month.

To change the time interval to the current quarter:

• Delete the current Month interval by selecting the X icon to the left of the filter

• Locate the desired interval in the Object Browser to the left of the report filter display

NOTE:  The Object Browser displays the objects that are currently used in the report 
definition. You can display all the available objects defined in the project by 
selecting All objects.
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• Select the Attributes folder

• Select Time from the attribute list

• Select Quarter from the list of time attributes

The design mode page displays new Quarter report filter value selection fields

• Select the Select option to display the available values for the Quarter interval
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• Select the desired value using the selection arrows

• Use the checkmark  icon to complete your selection

The design mode page displays the new Quarter report filter.

• Select Execute Report to create the report using data only from the second quarter

You can save the report to the My Reports folder, where it will be available to you in 
future sessions.

Sorting Report Data

Grids within InQuira Analytics reports are organized, or sorted, by one element.

The Popular Concepts report displays concepts, sorted by the number of questions they 
were displayed in.

When analyzing report data that is presented in a table, you may want to reorganize the 
report by sorting the data by a different metric.

NOTE:  You can sort data within a column from lowest value to highest (ascending) or 
from highest value to lowest (descending).

To sort a report column:

• Select the column by right-clicking the column label 
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The drop-down menu displays.

• Select Sort.

NOTE:  You can also use the Sort Buttons option on the View menu to add sorting 
controls to each column in the grid.

Adding Sort Buttons to Grid Columns
You can add sort buttons to the grid columns in a report using the Sort Buttons option on 
the View drop-down menu.

To add sort buttons:

• Select the View drop-down menu

• Select the Sort Buttons option

The sort buttons display on the grid column headings:

The direction of the button indicates the order in which the data is being sorted.
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Moving Display Columns

You can move columns within the report display to emphasize or clarify some aspect of 
the report data.

• Right-click on the column label of the column you would like to move to display the 
drop-down menu

• Select Move to move the column one position in the selected direction.

• Repeat the process to continue moving columns over.

NOTE:  You can also use the Pivot Buttons option on the View menu to add positioning 
controls to each column in the grid as described in Adding Pivot Buttons to 
Display Columns on page 86.

Adding Pivot Buttons to Display Columns
You can add sort buttons to the grid columns in a report using the Pivot Buttons option 
on the View drop-down menu.

To add sort buttons:

• Select the View drop-down menu
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• Select the Pivot Buttons option

The pivot buttons display on the grid column headings:

The arrow buttons indicate the directions available for each column to move. Use the 
delete button [X] to delete the column from the report, as described in Removing Columns 
from the Report Display on page 87.

Removing Columns from the Report Display

You can remove columns from report displays using the drop-down menu from the 
column label.

NOTE:  InQuira Analytics will restore columns that you remove when you re-create the 
report, or when you return to the report from another InQuira Analytics display.

To remove a report column:

• Select the column by right-clicking the column label.

• Select Remove from Grid.
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Specifying Background Report Creation and Caching

You can specify to have InQuira Analytics create selected reports in the background, and 
store the data in cache memory by subscribing to reports. Subscriptions are an efficient 
way to generate frequently-used reports that are time-consuming, since you do not need to 
log onto the application and wait for InQuira Analytics to process the report data.

You subscribe to reports by:

• Selecting the Subscribe option from the Reports Group menu for the desired report

• Specifying a schedule

NOTE:  You can view the list of reports that you have subscribed to by selecting the My 
Subscriptions tab located at the top of the InQuira Analytics display.

To subscribe to a report:

• Navigate to the report of interest, and select Subscriptions

The current subscriptions for the selected report are displayed.

To add a subscription to a report:

• Select Add subscription
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The Subscriptions form displays:

• Select On Database Load as the Schedule option to create and store the report 
whenever new data is loaded into the reporting database

• Select any other options specific to the report you want to run

Saving Reports for Deferred Actions

You can save a report in its current state using the History List, so that you can perform 
some later action on it. The History List is convenient in cases where you are:

• Viewing and editing multiple reports that you want to print or export later

• Waiting for InQuira Analytics to create a selected report

NOTE:  InQuira Analytics maintains the History List only for the length of your session. If 
you log out, or if InQuira Analytics terminates your session for another reason 
(time out, etc.), the History List will be deleted. 
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Adding a Viewed Report to Your History List

To add a report that you have viewed or edited to your History List:

• Select the File drop-down menu

The File menu displays.

• Select Add to History List from the File menu

The confirmation message displays:

NOTE:  You can view the History List to review the items you have added and perform 
additional actions, such as exporting and printing to PDF, using the History List 
tab.
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Adding a Report to Your History List During Creation

InQuira Analytics may require significant processing time to create some reports 
containing large quantities of data. You can effectively move the report creation process to 
the background and continue with other InQuira Analytics tasks by adding the report to 
your History List during processing.

InQuira Analytics displays the following message during prolonged report creation:

To add the report to your History List:

• Select the Add to my History List option

InQuira Analytics updates the message:

• Select the Go to my History List option

InQuira Analytics displays the History List, showing the report creation in process:

You can select the Shared Reports tab from the History List page to resume InQuira 
Analytics tasks while the report is being created.
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NOTE:  You can view the History List to review the items you have added and perform 
additional actions, such as exporting and printing to PDF.

Viewing Saved Reports and Performing Deferred Actions

You can view the list of reports that you saved, and perform deferred actions, such as 
exporting and viewing details, by displaying the History List page.

To display the History List page:

• Select the History List tab at the top of the InQuira Analytics display

The History List page displays:

The History List displays the reports that you have added during the current session, and 
provides options to:

• Export selected reports, as described in Exporting Reports on page 94.

• Export selected reports to portable document format (PDF) for printing and 
distribution, as described in Exporting Reports to PDF Format on page 92.

• View details about the report and the settings used to create it

Exporting Reports to PDF Format

You can export a report to save the data in PDF file format. You can export to PDF from:

• The current report page

• The History List

To export a report to PDF:

• Select the PDF option from:

- The function icons   on the current report or History List

- The Report menu of the current report
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The export options page displays:

• Specify the desired formatting options for the PDF file, or use the default values 
specified in your project or user preferences

• Select Export.

Option Description
Export Use this setting to specify whether to export the entire report or 

the portion displayed.
Header and Footer Use this setting to specify to use the settings specified in the 

report or to use custom settings on all reports when exporting to 
PDF. Use the Edit Custom Settings link to define custom 
headers and footers.

Scaling Use this setting to specify whether the report's content size will 
be adjusted by default. The choices are listed in the two 
following rows:

Adjust font to __% of 
original size

Use this setting to manually set the percent to shrink.

Fit to __page wide by 
__tall

Use this setting to specify the page dimensions to which the 
contents will be fit.

Orientation Use this setting to specify whether reports are exported to PDF 
in landscape (horizontal) or portrait (vertical) orientation.

Print cover page with 
filter details

Use this setting to print the current report filter information on a 
separate cover page.

Expand all page-by 
fields

Use this setting to print all combinations of items in the Page-by 
axis when printing a report that has one or more items in the 
Page-by axis. To print only the items currently displayed, clear 
this check box.
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Exporting Reports

You can export a report to save the data in a file format other than PDFs. You can export 
reports from:

• The current report page

• The History List

To export a report:

• Select the Export option from:

- The function icon   on the current report or History List

- The Report menu of the current report

Advanced Options Description
Paper size Use this setting to specify the paper size on which to export a 

report.
Margins (inches) Use this setting to specify the top, left, right, and bottom 

margins. For reports to print correctly, these margin settings 
must match those in the browser's File, Page Setup option. The 
default value for all margins is 0.75 inches.

Maximum header/
footer size (inches)

Use this setting to specify the size at which the report header and 
footer can be overwritten.

If the header or footer is larger than its maximum size and the 
report must use the space to display its content, the header or 
footer is cut off by the report content. If the report does not use 
the space, the entire header or footer displays regardless of size. 
The default value for each is 5 inches.

Use bitmaps for 
graphs

Use this setting to embed bitmaps rather than vector graphics in 
the PDF.

Embed fonts Use this setting to include font bit maps and metrics in the PDF. 
Use this option if there are fonts in the report that may not be 
available on the printers used to output the report.
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The export options page displays:

• Specify the desired formatting options for the exported report, or use the default values 
specified in your project or user preferences

• Select Export.

Option Description
Export: Use this option to export the entire report or only the portion 

of the report that is currently displayed.
Excel with formatting Use this option to export the report to Microsoft Excel 

(Version 2000 SR-1 or later). You must have a supported 
version of Microsoft Excel installed on the local system. The 
export process will open Excel with the exported file in a 
separate browser window. Save the file to complete the 
export process.

HTML Use this option to export the report to an HTML file. The 
export process will open the HTML file in a separate browser 
window. Save the file to complete the export process.

Export filter details Use this field to include the report filter information within 
the exported report.
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Printing Reports

You can print reports from the current report page.

To print a report:

• Select the Print option from:

- The function icon  on the current report

- The Report menu of the current report

The print options page displays:

• Specify the desired printing options, or use the default values specified in your project 
or user preferences.

• Select Show Printable Version.

The Printable Version will display.

• Select the Print Icon  to begin printing.

Option Description
Header and Footer Use this setting to specify default headers and footers within 

report settings or to specify a customized header and footer on 
all reports. Use the Edit Custom Settings link to customize 
headers and footers.
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Print the grid and the 
graph on the same page

Use this setting to specify that the grid and the graph will be 
printed on the same page when printing a report displayed in 
Grid and Graph mode.

If you select the check box, the graph you are currently viewing 
will be placed on one page along with the corresponding grid. 
Additional sections of the report, if any, will be displayed on 
subsequent pages, always with the graph and its corresponding 
grid rows on the same page.

If you clear the check box, the grid and graph will print on 
separate pages.

Scaling Use this setting to adjust the amount of the report's content (and 
thus, the size of the font) that prints on a page. Select either to:

• adjust the font as percent of original size

• fit to page for all columns, all rows, or both
Print cover page with 
filter details

Use this setting to print the filter details of the report on a 
separate page before the contents of the report.

Expand all page-by 
fields

Use this setting to print all combinations of items in the Page-
by axis when printing a report that has one or more items in the 
Page-by axis. To print only the items currently displayed, clear 
this check box.

Advanced Option Description
Paper size Use this setting to specify the paper size on which to export a 

report.
Margins (inches) Use this setting to specify the top, left, right, and bottom 

margins. For reports to print correctly, these margin settings 
must match those in the browser's File, Page Setup option. The 
default value for all margins is 0.75 inches.

Maximum header/
footer size (inches)

Use this setting to specify the size at which the report header 
and footer can be overwritten.

If the header or footer is larger than its maximum size and the 
report must use the space to display its content, the header or 
footer is cut off by the report content. If the report does not use 
the space, the entire header or footer displays regardless of 
size. The default value for each is 5 inches.

Use bitmaps for graphs Use this setting to embed bitmaps rather than vector graphics in 
the PDF.
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Deleting Existing Data from the Report Cache

The report caches are dedicated storage that InQuira Analytics uses to maintain quick 
access to the report data. You must delete any cached report data. To delete data from the 
reporting cache storage:

• Execute the following command:
         <InQuira Analytics installation dir>\analytics\common\Data Loading\InvalidateCaches.bat

This program invalidates the caches: new reports will be generated from the current 
InQuira Analytics database. 

Embed fonts Use this setting to include font bit maps and metrics in the PDF. 
Use this option if there are fonts in the report that may not be 
available on the printers used to output the report.

Orientation Use this setting to select either portrait or landscape page 
orientation.

Paper size Use this setting to select the paper size for printed reports.
Margins (inches) Use this setting to set the top, left, right and bottom margins.

IMPORTANT:  These settings must match corresponding 
browser settings for reports to print correctly.

Maximum header/
footer size (inches)

Use this setting to set the size at which the report header and 
footer can be overwritten. If the header or footer is larger than 
its maximum size and the report must use the space to display 
its content, the header or footer is cut off by the report content. 
If the report does not use the space, the entire header or footer 
displays regardless of size.
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Chapter 5 InQuira Intelligent Search Analytics Reports

InQuira Analytics reports provide information about which questions a user asks, the 
responses to the questions, the responses on which the user clicks, how the user rates the 
responses, as well as the system performance, system usage (how many sessions for 
specific period), etc. InQuira Analytics has three types of reports: 

• InQuira Analytics Standard Reports, which provide a default high-level view of 
system data

• InQuira Analytics Analysis Reports, which provide a more detailed session-level 
view that you drill down to from a Standard report

• InQuira Analytics Detail Reports, which provide a very specific activity-level view 
that you drill down to from Standard reports, Analysis reports, or from other Detail 
reports

You can filter reports by selecting report creation parameters prior to running the report, 
as described in Intelligent Search Analytics Report Creation Parameters on page 35. 
Once the report is displayed you can apply report Page-by filters, as described in Filtering 
Intelligent Search Analytics Report Displays on page 74. You can also drill down from a 
report to view different time segments, as described in Drilling Down to View Different 
Time Segments on page 39, or view Analysis and Detail reports, as described in Drilling 
Down to View Analysis and Detail Reports on page 40.

InQuira Analytics Standard Reports

Standard reports are the out-of-the-box reports provided with the application. The InQuira 
Analytics reports include several subcategories:

• Question Analysis Reports, which provide information about the questions users are 
asking, and how well your site is able to respond to them
Using InQuira Analytics 99



• User Experience Analysis Reports, which provide information about how users are 
using and responding to your site, including click-thru rates and user ratings for 
application responses

• User Interest Analysis Reports, which provide information about which elements of 
your site are most or least frequently used

• Session Analysis Reports, which provide information about session and activity levels 
and their associated click-thru rates

• Performance Analysis Reports, which provide information about system response 
times for user activities

• Dashboard Reports, which provide quick high-level indicators and metrics for what is 
occurring on your site

These subcategories appear as folders in the application's user interface. 

Individual report descriptions include details about the report's fields, and drill-down paths 
to Analysis and Detail sub-reports.

Question Analysis Reports

Question Analysis reports provide information about the questions users are asking, and 
how well your site is able to respond to those questions. 

Question Analysis reports include:

• Intent Coverage Report, which shows how well intents and intent responses are 
aligned with user questions

• Queries without Responses Report, which shows activities where no response was 
returned

• Question Usage Report, which shows the number of questions that are being asked 
and the corresponding click-thru rate

• Words without Concepts Report, which shows words appearing in user questions that 
are unknown to the system
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Intent Coverage Report
The Intent Coverage Report shows you how well intents are working for a reporting 
period.

The answers are sorted by time period. The default view displays:

• Question Count – the number of questions

• Matched No Intent – the percentage of questions that fail to match any system-
defined intent

• Matched with No Response – the percentage of questions that match a system-
defined intent but do not have any assigned intent response

• Matched With Assigned Response – the percentage of questions that match a 
system-defined intent and have an assigned intent response 

• Matched With Inherited Response – the percentage of questions that match a system 
defined intent but do not have any assigned response where a parent intent's response 
was used

Use the following report creation parameters to tailor the report:

• User Segment

• Language

• Query Source

• Cluster

• Concept

See Intelligent Search Analytics Report Creation Parameters on page 35 for more 
information on using report creation parameters.
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You can filter the report data by Year, Quarter, and Month (see Filtering Intelligent 
Search Analytics Report Displays on page 74 for more information on using the Page-By 
filters).

You can drill down from a row in the Analysis column to display the following Analysis 
and Detail reports:

• Click-thru and Response Time Analysis Report on page 146

• Intent/Concept Analysis Report on page 148

• Session Navigation Analysis Report on page 149

• Question Details Report on page 154

• Question Matched No Intent Details Report on page 156

• Question Matched No Intent Response Details Report on page 157

Queries without Responses Report
The Queries without Responses Report shows you sessions and activities for which no 
response is returned.

The results are sorted by time period. The default view displays:

• Query Activity Count – The total number of query activities for the time period. 
Query activities are the activities with types of: Basic Search, Facet Selection Search, 
Process Wizard Completion and Search, Escalation Attempt, Escalation no answer and 
compiled.

• % Query Activity with No Response – The percentage of query activities for which 
there was no response 

• Session Count – The number of sessions for the time period. 
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• % Session with No Response – The percentage of sessions for which there was no 
response for the time period.

Use the following report creation parameters to tailor the report:

• User Segment

• Language

• Query Source

• Activity Type

• Cluster

• Concept

See Intelligent Search Analytics Report Creation Parameters on page 35 for more 
information on using report creation parameters.

You can filter the report data by Year, Quarter, and Month (see Filtering Intelligent 
Search Analytics Report Displays on page 74 for more information on using the Page-By 
filters).

You can drill down from a row in the Analysis column to display the following Analysis 
and Detail reports:

• Click-thru and Response Time Analysis Report on page 146

• Intent/Concept Analysis Report on page 148

• Session Navigation Analysis Report on page 149

• Question Details Report on page 154
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Question Usage Report
The Question Usage Report shows the number of questions that are being asked and the 
corresponding click-thru rate.

The results are sorted by time period. The default view displays:

• Total Question Count – the number of questions for the time period 

• Click-thru Question Count – the number of questions for the time period where at 
least one click-thru occurred

• No Click-thru Question Count – the number of questions for the time period where 
no click-thrus occurred

• Click-thru Rate – the percentage of questions for the time period where at least one 
click-thru occurred

Use the following report creation parameters to tailor the report:

• User Segment

• Language

• Query Source

• Cluster

• Concept

• Intent

• Question Click-thru or Not

See Intelligent Search Analytics Report Creation Parameters on page 35 for more 
information on using report creation parameters.
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You can filter the report data by Year, Quarter, and Month (see Filtering Intelligent 
Search Analytics Report Displays on page 74 for more information on using the Page-By 
filters).

You can drill down from a row in the Analysis column to display the following Analysis 
and Detail reports:

• Click-thru and Response Time Analysis Report on page 146

• Intent/Concept Analysis Report on page 148

• Session Navigation Analysis Report on page 149

• Question Details Report on page 154

Words without Concepts Report
The Words without Concepts Report lists words appearing in user questions that have 
no associated concepts and are not recognized by the system.

The results are sorted by Question Count in descending order. The default view displays:

• Question Count – the number of questions that included the unrecognized word

• % Question Count – the percentage of questions that included the unrecognized word

• Click-thru Rate – the percentage of questions that included the unrecognized word 
and at least one click-thru occurred
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NOTE:  You can exclude irrelevant words from the Words without Concepts report by 
adding words as conditions to the report's filter. See the section on Excluding 
Words from the Words without Concepts Report for more information.

You can filter the report data by Year, Quarter, Month, Week, and Day (see Filtering 
Intelligent Search Analytics Report Displays on page 74 for more information on using 
the Page-By filters).

You can drill down from a row in the Analysis column to display the following Analysis 
and Detail reports:

• Click-thru and Response Time Analysis Report on page 146

• Question Response Details Report on page 153

• Words without Concepts Details Report on page 160

• Question Details Report on page 154

User Experience Analysis Reports

User Experience Analysis reports provide information about how users are using and 
responding to your site, including click-thru rates and how users rated the application's 
responses to questions. 

User Experience Analysis reports include:

• Activity Usage Report, which shows the number of user activities and the 
corresponding click-thru rate

• Process Wizards Usage Report, which shows how customers are using process 
wizards, including which are the most frequently used

• User Feedback Report, which shows how customers rated the answers provided by 
the site

• Facet Usage Report, which shows how many times users select specific facets

• Response Usage Report, which shows how many times users click through on 
answers
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Activity Usage Report
The Activity Usage Report shows the number of user activities and the corresponding 
click-thru rate.

The results are sorted by time period (Month by default). The default view displays:

• Response Activity Count – the total number of response activities for the time period

• Click-thru Response Activity Count – the number of activities where at least a single 
click-thru occurred

• No Click-thru Response Activity Count – the number of activities where no click-
thru occurred

• Click-thru Rate – the percentage of activities where at least a single click-thru 
occurred 

Use the following report creation parameters to tailor the report:

• User Segment

• Language

• Query Source

• Activity Type

• Cluster

• Concept

• Intent

• Question Click-thru or Not

See Intelligent Search Analytics Report Creation Parameters on page 35 for more 
information on using report creation parameters.
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You can filter the report data by Year, Quarter, and Month (see Filtering Intelligent 
Search Analytics Report Displays for more information on using the Page-By filters).

You can drill down from a row in the Analysis column to display the following Analysis 
reports:

• Click-thru and Response Time Analysis Report on page 146

• Intent/Concept Analysis Report on page 148

• Session Navigation Analysis Report on page 149

• Question Details Report on page 154

Process Wizards Usage Report
The Process Wizards Usage Report shows how customers are interacting with process 
wizards.

The results are sorted by process wizard name. The default view displays:

• Displayed Count – the number of times this process wizard was displayed as a 
response 

• Invoked Count – the number of times this process wizard was invoked after it was 
displayed as a response

• % Invoked – the percentage of times this process wizard was invoked after it was 
displayed as a response

• Finished Count – the number of times a process wizard finished after it was invoked

• % Finished After Invoked – the percentage of times a process wizard finished after it 
was invoked
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Use the following report creation parameters to tailor the report:

• Process Wizard Displayed Top or Bottom

• Enter the Top/Bottom number

See Intelligent Search Analytics Report Creation Parameters on page 35 for more 
information on using report creation parameters.

You can filter the report data by Year, Quarter, Month, Week, and Day (see Filtering 
Intelligent Search Analytics Report Displays on page 74 for more information on using 
the Page-By filters).

You can drill down from a process wizard row to display the following Analysis and 
Detail reports:

• Process Wizard Details Report on page 162

• Session Navigation Analysis Report on page 149

• Click-thru and Response Time Analysis Report on page 146

• Intent/Concept Analysis Report on page 148

User Feedback Report
The User Feedback Report provides information about how customers rated the answers 
provided by the application.

The Web interface can elicit user feedback about how well the application is answering 
questions. Refer to Implementing User Feedback Collection in the Intelligent Search 
Application Developers' Guide for more information on implementing the user feedback 
feature.

The user feedback feature prompts users to rate answers by selecting from the following 
rating levels:

NOTE:  The labels for the rating levels are configurable; InQuira Analytics displays the 
rating levels as they are configured in your application, which may differ from the 

Rating Level Default Label
5 Absolutely!

4 Usually

3 Sure

2 Hardly

1 Not even close!
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defaults listed above. Refer to the section on Updating Labels for the User 
Feedback Report for information on how to configure rating levels.

The results are sorted by time period. The default view displays:

• Session Count – the number of sessions for the rating level

• % Session Count – the percentage of sessions with the rating level

Use the following report creation parameters to tailor the report:

• User Segment

• Language

See Intelligent Search Analytics Report Creation Parameters on page 35 for more 
information on using report creation parameters.

You can filter the report data by Year, Quarter, Month, Week, Day, and Hour (see 
Filtering Intelligent Search Analytics Report Displays on page 74 for more information 
on using the Page-By filters).

You can drill down within a row to display the following Analysis reports:
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• Rating Details Analysis Report- lists any comments associated with feedback scores.

• User Feedback Analysis Report on page 150

• Click-thru and Response Time Analysis Report on page 146

• Intent/Concept Analysis Report on page 148

• Session Navigation Analysis Report on page 149
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Facet Usage Report
The Facet Usage Report shows how many times users select specific facets.

The results are sorted by time period. The default view displays:

• Session Count – the number of sessions 

• Avg. Facet Level – the average facet level selected based on sessions where at least 
one facet is selected

• % 1-3 Levels – the percentage of sessions where users selected facets with an average 
level between 1 and 3 

• 1-3 Click-thru Rate – the percentage of sessions where the selected facet level was 
between 1 and 3 and where at least one click-thru occurred

• % 4-6 Levels – the percentage of sessions where users selected facets where the 
average level is between 4 and 6

• 4-6 Click-thru Rate – the percentage of sessions where the selected facet level was 
between 4 and 6 and where at least one click-thru occurred

• % >6 Levels – the percentage of sessions where users selected facets with an average 
level of greater than 6

• >6 Click-thru Rate – the percentage of sessions where the selected facet level was 
greater than 6 and where at least one click-thru occurred

Use the following report creation parameters to tailor the report:

• User Segment

• Language

• Query Source
112 Using InQuira Analytics



• Cluster

• Concept

See Intelligent Search Analytics Report Creation Parameters on page 35 for more 
information on using report creation parameters.

You can filter the report data by Year, Quarter, Month, and Confidence Level (see 
Filtering Intelligent Search Analytics Report Displays on page 74 for more information 
on using the Page-By filters).

You can drill down from a row in the Analysis column to display the following Analysis 
reports:

• User Feedback Analysis Report on page 150

• Intent/Concept Analysis Report on page 148

• Session Navigation Analysis Report on page 149

Response Usage Report
The Response Usage Report describes how many times users click through on responses 
the system provides.

The results are sorted by time period. The default view displays:

• Response Activity Count – the number of user response activities

• Avg. Number of Displayed Responses – the average number of responses displayed 
to the user

• Avg. Clicked Response Order – the average position in the response queue of the 
clicked response
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• %Order 1-3 – the percentage of activities where the average position of the clicked 
response was between first and third

• %Order 4-6 – the percentage of activities where the average position of the clicked 
response was between fourth and sixth

• % Order > 6 – the percentage of activities where the average position of the clicked 
response was greater than sixth

• % Click on 0 Responses – the percentage of activities where the user did not click on 
any displayed response

NOTE:  A single activity can include multiple clicks on responses which in turn may result 
in the sum of the %Order columns exceeding 100%.

Use the following report creation parameters to tailor the report:

• User Segment

• Language

• Query Source

• Activity Type

• Cluster

• Concept

• Intent

• Portlet

See Intelligent Search Analytics Report Creation Parameters on page 35 for more 
information on using report creation parameters.

You can filter the report data by Year, Quarter, Month, and Confidence Level (see 
Filtering Intelligent Search Analytics Report Displays on page 74 for more information 
on using the Page-By filters).

You can drill down from a row in the Analysis column to display the following Analysis 
reports:

• User Feedback Analysis Report on page 150 

• Intent/Concept Analysis Report on page 148 

• Session Navigation Analysis Report on page 149 

• Question Details Report on page 154 
114 Using InQuira Analytics



User Interest Analysis Reports

User Interest reports provide information about which elements of your site that are the 
most or least frequently used. 

User Interest reports include:

• Concept Breakdown Report, which shows how well concepts match user questions, 
and the click-thru rate for concepts

• Intent Breakdown Report, which shows how well intents match user questions, and 
the click-thru rate for intents

• Popular Question Clusters Report, which shows the question clusters and the 
associated questions and sessions that have the most or least activity associated with 
them

• Popular Responses Report, which shows responses that have the most or least activity 
associated with them

• Facet Breakdown Report, which shows how often users click facets

• Popular Concepts Report, which shows concepts ranked by the number of questions 
associated with them

• Popular Questions Report, which shows a ranked list of the most frequently asked 
questions

Concept Breakdown Report
The Concept Breakdown Report shows the distribution of user questions that match 
system concepts. 

The default view displays:

• Directly Matched Question Count – the number of questions that directly match this 
concept

• % Directly Matched Question Count – the percentage of questions that directly 
match this concept

• Descendant Matched Question Count – the number of questions that match the 
children of this concept

• % Descendant Matched Question Count – the percentage of questions that match 
the children of this concept
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Use the following report creation parameters to tailor the report:

• User Segment

• Language

• Query Source

• Cluster

• Question Count Matched Concept Top or Bottom

• Enter the Top/Bottom Number

See Intelligent Search Analytics Report Creation Parameters on page 35 for more 
information on using report creation parameters.

You can filter the report data by Year, Quarter, Month, and Confidence Level (see 
Filtering Intelligent Search Analytics Report Displays on page 74 for more information 
on using the Page-By filters).

You can drill down on a concept row to display:

• A lower level concept

• Concept Details Report on page 159

• Question Details Report on page 154

• User Feedback Analysis Report on page 150 

• Intent/Concept Analysis Report on page 148 

• Session Navigation Analysis Report on page 149 

Intent Breakdown Report
The Intent Breakdown Report shows the distribution of user questions that match 
system intents.

The results are sorted by Intents in descending order. The default view displays:

• Direct Matched Question Count – the number of questions that directly match this 
intent

• % Direct Matched Question Count – the percentage of questions that match this 
intent
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• Descendant Matched Question Count – the number of questions that match the 
children of this intent

• % Descendant Matched Question Count – the percentage of questions that match 
the children of this intent

Use the following report creation parameters to tailor the report:

• User Segment

• Language

• Query Source

• Cluster

• Concept

• Intent Breakdown Question Count Top/Bottom

• Enter the Top/Bottom number

See Intelligent Search Analytics Report Creation Parameters on page 35 for more 
information on using report creation parameters.

You can filter the report data by Year, Quarter, Month, and Confidence Level (see 
Filtering Intelligent Search Analytics Report Displays on page 74 for more information 
on using the Page-By filters).

You can drill down on an intent row to display:

• A lower level intent

• Intent Details Report on page 154

• Question Response Details Report on page 153

• User Feedback Analysis Report on page 150

• Session Navigation Analysis Report on page 149
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Popular Question Clusters Report
The Popular Question Clusters Report shows a list of question clusters (groups of 
frequently occurring questions that express the same idea or intent) with the number of 
questions and sessions associated with them. 

The results are sorted by question cluster name. The default view displays:

• Question Count – the number of questions in this cluster 

• % Question Count – the percentage of questions belonging to this cluster against the 
total questions

• Session Count – the number of sessions containing this cluster

• % Session Count – the percentage of sessions with at least one question belonging to 
this cluster (note that a question can belong to more than one cluster)

Use the following report creation parameters to tailor the report:

• User Segment

• Language

• Query Source

• Concept

• Intent

• Cluster Question Count Top or Bottom

• Enter the Top/Bottom number

See Intelligent Search Analytics Report Creation Parameters on page 35 for more 
information on using report creation parameters.

You can filter the report data by Year, Quarter, Month, and Confidence Level (see 
Filtering Intelligent Search Analytics Report Displays on page 74 for more information 
on using the Page-By filters).
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You can drill down from a question cluster row to display the following Analysis and 
Detail reports:

• User Feedback Analysis Report on page 150 

• Intent/Concept Analysis Report on page 148 

• Session Navigation Analysis Report on page 149 

• Question Response Details Report on page 153 

• Concept Details Report on page 159 

• Question Details Report on page 154 on page 

Popular Responses Report
The Popular Responses Report shows how responses are used in the system. 

The results are sorted by Activity Count. The default view displays:

• Activity Count – the number of activities for this response 

• Displayed Count – the number of times this response was displayed

• % Displayed – the percentage, based on the total activities, that this response was 
displayed for the time period

• Click-thru Rate – the percentage of activities for which this response was clicked at 
least once
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Use the following report creation parameters to tailor the report:

• User Segment

• Language

• Query Source

• Activity Type

• Cluster

• Concept

• Intent

• Portlet

• Popular Response Activity Count Top or Bottom

• Enter the Top/Bottom number

See Intelligent Search Analytics Report Creation Parameters on page 35 for more 
information on using report creation parameters.

You can filter the report data by Year, Quarter, Month, and Confidence Level (see 
Filtering Intelligent Search Analytics Report Displays on page 74 for more information 
on using the Page-By filters).

You can drill down within a response to display the following Analysis and Detail reports:

• Question Response Details Report on page 153 

• User Feedback Analysis Report on page 150 

• Intent/Concept Analysis Report on page 148 

• Session Navigation Analysis Report on page 149 

• Question Details Report on page 154
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Facet Breakdown Report
The Facet Breakdown Report shows how often users click facets and the corresponding 
click-thru rate. 

The results are sorted by Session Count in descending order. The default view displays:

• Session Count – the number of sessions during which this facet was selected

• Selection Count – the number of times this facet was selected

• % Of Total Selected – the percentage that the selection count represents based on the 
total selection count

• Click-thru Rate – the percentage where the facet was selected and at least one click-
thru occurred

Use the following report creation parameters to tailor the report:

• User Segment

• Language

• Session Count Top or Bottom

• Enter the Top/Bottom number

See Intelligent Search Analytics Report Creation Parameters on page 35 for more 
information on using report creation parameters.

You can filter the report data by Year, Quarter, Month, and Confidence Level (see 
Filtering Intelligent Search Analytics Report Displays on page 74 for more information 
on using the Page-By filters).

You can drill down on a facet row to display:

• A lower level facet

• User Feedback Analysis Report on page 150 

• Session Navigation Analysis Report on page 149 
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Popular Concepts Report
The Popular Concepts Report shows concepts ranked by the number of questions 
associated with them.

The results are sorted by Question Count. The default view displays:

• Question Count – the number of questions that match the concept 

• % Question Count – the percentage of questions that match the concept

Use the following report creation parameters to tailor the report:

• User Segment

• Language

• Query Source

• Cluster

• Concept Question Count Top or Bottom

• Enter the Top/Bottom number

See Intelligent Search Analytics Report Creation Parameters on page 35 for more 
information on using report creation parameters.

You can filter the report data by Year, Quarter, Month, and Confidence Level (see 
Filtering Intelligent Search Analytics Report Displays on page 74 for more information 
on using the Page-By filters).
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You can drill down within a concept to display the following Analysis and Detail reports:

• User Feedback Analysis Report on page 150 

• Intent/Concept Analysis Report on page 148 

• Concept Details Report on page 159 

• Question Response Details Report on page 153 

• Question Details Report on page 154 on page 

Popular Questions Report
The Popular Questions Report shows a ranked list of normalized questions asked by 
users.
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The results are sorted by Question Count based on a normalized question. The default 
view displays:

• Question Count – the number of questions that match the normalized question

• % Question Count – the percentage of questions that match the normalized question

• Click-thru Rate – the percentage of questions that match the normalized question and 
at least one click-thru occurred

Use the following report creation parameters to tailor the report:

• User Segment

• Language

• Query Source

• Cluster

• Concept

• N Question count Top or Bottom

• Enter the Top/Bottom number

See Intelligent Search Analytics Report Creation Parameters on page 35 for more 
information on using report creation parameters.

You can filter the report data by Year, Quarter, Month, and Confidence Level (see 
Filtering Intelligent Search Analytics Report Displays on page 74 for more information 
on using the Page-By filters).

You can drill down from a normalized question to display the following Analysis and 
Detail reports:

• User Feedback Analysis Report on page 150 

• Intent/Concept Analysis Report on page 148 

• Concept Details Report on page 159

• Question Response Details Report on page 153 
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Performance Analysis Reports

Performance Analysis reports provide information about your system's response times for 
user activities. 

Performance Analysis reports include:

• Response Timing Report on page 125, which shows response times for user activities

Response Timing Report
The Response Timing Report shows the response time for user activities.

The results are sorted by time period. The default view displays:

• Activity Count – the total number of activities for the time period 

• Avg. Activity Response Time – the average time for the system to respond to 
activities

• %<4 Seconds – the percentage of activities where the average response time was less 
than 4 seconds

• % 4-10 Seconds – the percentage of activities where the average response time was 4 
or more seconds and less than 10 seconds

• %10-20 Seconds – the percentage of activities where the average response time was 
10 or more seconds and less than 20 seconds

• %20-30 Seconds – the percentage of activities where the average response time was 
20 or more seconds and less than 30 seconds

• %>=30 Seconds – the percentage of activities where the average response time was 
30 seconds or more
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Use the following report creation parameters to tailor the report:

• User Segment

• Language

• Query Source

• Activity Type

• Cluster

• Concept

See Intelligent Search Analytics Report Creation Parameters on page 35 for more 
information on using report creation parameters.

You can filter the report data by Year, Quarter, Month, and Confidence Level (see 
Filtering Intelligent Search Analytics Report Displays on page 74 for more information 
on using the Page-By filters).

You can drill down from a row in the Analysis column to display the following Analysis 
and Detail reports:

• User Feedback Analysis Report on page 150 

• Intent/Concept Analysis Report on page 148 

• Session Navigation Analysis Report on page 149 

• Question Details Report on page 154
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Session Analysis Reports

Session Analysis reports provide information about the session and activity levels and the 
associated click-thru rate.

Session Analysis reports include:

• Session Activity Count Report, which shows activity count averages and click-thru 
rates

• Session Usage Report, which shows the number of sessions and the corresponding 
click-thru rate

Session Usage Report
The Session Usage Report shows the number of sessions and the corresponding click-
thru rate.

The results are sorted by time period. The default view displays:

• Total Session Count – the number of sessions for the time period 

• Click-thru Session Count – the number of sessions for the time period where at least 
one click-thru occurred

• No Click-thru Session Count – the number of sessions for the time period where no 
click-thrus occurred

• Click-thru Rate – the percentage of sessions for the time period where at least one 
click-thru occurred
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Use the following report creation parameters to tailor the report:

• User Segment

• Language

• Query Source

• Cluster

• Concept

• Intent

See Intelligent Search Analytics Report Creation Parameters on page 35 for more 
information on using report creation parameters.

You can filter the report data by Year, Quarter, Month, and Confidence Level (see 
Filtering Intelligent Search Analytics Report Displays on page 74 for more information 
on using the Page-By filters).

You can drill down within a row in the Analysis column to display the following Analysis 
and Detail reports:

• User Feedback Analysis Report on page 150 

• Intent/Concept Analysis Report on page 148 

• Session Navigation Analysis Report on page 149 

• Question Details Report on page 154
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Session Activity Count Report
The Session Activity Count Report shows the activity count averages and click-thru rate 
for a reporting period. 

The answers are sorted by time period. The default view displays:

• Session Count – the number of sessions for the time period

• Click-thru Session Count – the percentage of sessions for which at least one click-
thru occurred

• Avg. Activity Count – the average number of activities per session

• % 1-3 Activities – the percentage of sessions with 1 – 3 activities

• % 1-3 Activities Click-thru Rate – the percentage of sessions with 1 – 3 activities for 
which at least one click-thru occurred

• % 4-6 Activities – the percentage of sessions that have 4 – 6 activities

• % 4-6 Activities Click-thru Rate – the percentage of sessions that have 4 – 6 
activities for which at least one click-thru occurred

• % >6 Activities – the percentage of sessions with more than 6 activities

• % >6 Activities Click-thru Rate – the percentage of sessions with more than 6 
activities for which at least one click-thru occurred
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Use the following report creation parameters to tailor the report:

• User Segment

• Language

• Query Source

• Cluster

• Concept

• Intent

See Intelligent Search Analytics Report Creation Parameters on page 35 for more 
information on using report creation parameters.

You can filter the report data by Year, Quarter, Month, and Confidence Level (see 
Filtering Intelligent Search Analytics Report Displays on page 74 for more information 
on using the Page-By filters).

You can drill down from a row in the Analysis column to display the following Analysis 
and Detail reports:

• User Feedback Analysis Report on page 150 

• Intent/Concept Analysis Report on page 148 

• Session Navigation Analysis Report on page 149 

• Question Details Report on page 154

Dashboard Reports

Dashboard reports provide quick high-level indicators and metrics for what is occurring 
on your site. 

The Dashboard reports include:

• Daily Dashboard Reports on page 131

• Weekly Dashboard Reports on page 136

• Monthly Dashboard Reports on page 141
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Daily Dashboard Reports
The Daily Dashboard Report shows data for the last two weeks and includes graphs for 
four standard reports: 

• Session Usage Report on page 132

• Escalation Report on page 133

• User Feedback Report on page 134

• Response Usage Report on page 135
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Session Usage Report
The Daily Dashboard Session Usage Report shows the number of sessions and the 
number of sessions where a click-thru occurred for each day of the last two weeks.

For each day, the report shows the following metrics:

• Session Count – the number of sessions

• Click-thru Session Count – the number of sessions where a click-thru occurred

• No Click-thru Session Count – the number of sessions where no click-thru occurred
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Escalation Report
The Daily Dashboard Escalation Report shows the rate of sessions that complete an 
escalation or are deflected for each day of the last two weeks.

For each day, the report shows the following metrics:

• Escalations Completed Rate – the percentage of escalations that were completed

• Escalations Deflected Rate – the percentage of escalations that were deflected
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User Feedback Report
The Daily Dashboard User Feedback Report shows the sessions count for each user 
feedback rating for the last two weeks.

For each rating, the report shows the following metric for the last two weeks:

• Session Count – the number of sessions where a user provided the rating
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Response Usage Report
The Daily Dashboard Response Usage Report shows the distribution of activities with 
their corresponding average clicked response order for the last two weeks.

For each rating, the report shows the following metric for the last two weeks:

• Response Activity Count – the number of response activities

• Avg. Number of Displayed Responses – the average number of displayed responses 
for each response activity

• Avg. Clicked Response Order – the average response clicked order for all response 
activities 

• Ordered 1-3 – the number of activities where the average response clicked was 
between 1 and 3

• Ordered 4-6 – the number of activities where the average response clicked was 
between 4 and 6

• Ordered >6 – the number of activities where the average response clicked was greater 
than 6
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Weekly Dashboard Reports
The Weekly Dashboard Report shows data for the last two months and includes graphs 
for four standard reports: 

• Session Usage Report on page 132

• Escalation Report on page 133

• User Feedback Report on page 134

• Response Usage Report on page 135
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Session Usage Report
The Weekly Dashboard Session Usage Report shows the number of sessions and the 
number of sessions where a click-thru occurred for each week of the last two months.

For each week, the report shows the following metrics:

• Session Count – the number of sessions

• Click-thru Session Count – the number of sessions where a click-thru occurred

• No Click-thru Session Count – the number of sessions where no click-thru occurred
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Escalation Report
The Weekly Dashboard Escalation Report shows the rate of sessions that complete an 
escalation or are deflected for each week of the last two months.

For each week, the report shows the following metrics:

• Escalations Completed Rate – the percentage of escalations that were completed

• Escalations Deflected Rate – the percentage of escalations that were deflected
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User Feedback Report
The Weekly Dashboard User Feedback Report shows the sessions count for each user 
feedback rating for the last two months.

For each rating, the report shows the following metric:

• Session Count – the number of sessions where a user provided the rating
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Response Usage Report
The Weekly Dashboard Response Usage Report shows the distribution of activities 
with their corresponding average clicked response order for the last two months.

For each rating, the report shows the following metric:

• Response Activity Count – the number of response activities

• Avg. Number of Displayed Responses – the average number of displayed responses 
for each response activity

• Avg. Clicked Response Order – the average response clicked order for all response 
activities 

• Ordered 1-3 – the number of activities where the average response clicked was 
between 1 and 3

• Ordered 4-6 – the number of activities where the average response clicked was 
between 4 and 6

• Ordered >6 – the number of activities where the average response clicked was greater 
than 6
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Monthly Dashboard Reports
The Monthly Dashboard Report shows data for the last two quarters and includes graphs 
for four standard reports: 

• Session Usage Report on page 127 

• Escalation Report on page 133

• User Feedback Report on page 134 

• Response Usage Report on page 135 
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Session Usage Report
The Monthly Dashboard Session Usage Report shows the number of sessions and the 
number of sessions where a click-thru occurred for the last two quarters.

For each month, the report shows the following metrics:

• Session Count – the number of sessions

• Click-thru Session Count – the number of sessions where a click-thru occurred

• No Click-thru Session Count – the number of sessions where no click-thru occurred
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Escalation Report
The Monthly Dashboard Escalation Report shows the rate of sessions that complete an 
escalation or are deflected for the last two quarters.

For each month, the report shows the following metrics:

• Escalations Completed Rate – the percentage of escalations that were completed

• Escalations Deflected Rate – the percentage of escalations that were deflected
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User Feedback Report
The Monthly Dashboard User Feedback Report shows the sessions count for each user 
feedback rating for the last two quarters.

For each rating, the report shows the following metric:

• Session Count – the number of sessions where a user provided the rating
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Response Usage Report
The Monthly Dashboard Response Usage Report shows the distribution of activities 
with their corresponding average clicked response order for the last two quarters.

For each rating, the report shows the following metric:

• Response Activity Count – the number of response activities

• Avg. Number of Displayed Responses – the average number of displayed responses 
for each response activity

• Avg. Clicked Response Order – the average response clicked order for all response 
activities 

• Ordered 1-3 – the number of activities where the average response clicked was 
between 1 and 3

• Ordered 4-6 – the number of activities where the average response clicked was 
between 4 and 6

• Ordered >6 – the number of activities where the average response clicked was greater 
than 6
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InQuira Analytics Analysis Reports

Analysis reports provide session-level analysis of data from standard reports.

NOTE:  Analysis reports are available only by drilling down from a standard report. They 
are not available as stand-alone reports.

Analysis reports include:

• Click-thru and Response Time Analysis Report on page 146 – which shows session 
response and click through statistics

• Intent/Concept Analysis Report on page 148 – which shows how well intents and 
concepts are working for your site

• Session Navigation Analysis Report on page 149 – which shows how often users 
click facets or a process wizard is invoked

• User Feedback Analysis Report on page 150 – which shows user evaluations of the 
responses returned for a question

Click-thru and Response Time Analysis Report

The Click-thru and Response Time Analysis Report shows session response and click-
thru statistics.

The results are sorted by Session name. The default view displays:

• Question Count – the number of questions for the session

• Activity Count – the number of activities for the session

• Click-thru Activity Count – the number of activities for the session where a click-
thru occurred

• Min Response Time – the minimum time for the system to respond to activities

• Max Response Time – the maximum time for the system to respond to activities

• Max Response Displayed – the maximum number of responses displayed for the 
session
146 Using InQuira Analytics



• Min Response Displayed – the minimum number of responses displayed for the 
session

• Max Response Display Order – the maximum position of responses displayed

• Min Response Display Order – the minimum position of responses displayed

• Session Count – the number of sessions reported on (always 1)

You can filter the report data by Year, Quarter, Month, and Confidence Level (see 
Filtering Intelligent Search Analytics Report Displays on page 74 for more information 
on using the Page-By filters).

You can drill down on in the session row to display:

• Question Response Details Report on page 153

• Intent Details Report on page 154

• Intent Response Details Report on page 161

• Rating Details Report on page 158

• Concept Details Report on page 159

• User Activity Details Report on page 162
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Intent/Concept Analysis Report

The Intent/Concept Analysis Report shows how well intents and concepts are working 
for your site.

The results are sorted by Session name. The default view displays:

• Max Direct Matched Intent Count – the maximum number of intents that match a 
question for the session

• Min Direct Matched Intent Count – the minimum number of intents that match a 
question for the session

• Question Matched No Intent – the number of questions that do not match any intent

• Max Direct Matched Concept Count – the maximum number of concepts that match 
a question for the session

• Min Direct Matched Concept Count – the minimum number of concepts that match 
a question for the session

• Question Matched No Concept Count – the number of questions that do not match 
any concept

• Session Count – the number of sessions covered by the report

You can filter the report data by Year, Quarter, Month, and Confidence Level (see 
Filtering Intelligent Search Analytics Report Displays on page 74 for more information 
on using the Page-By filters).
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You can drill down on a session row to display:

• Intent Details Report on page 154

• Intent Response Details Report on page 161 

• Question Response Details Report on page 153 

• Concept Details Report on page 159 

• User Activity Details Report on page 162 

• Rating Details Report on page 158 

Session Navigation Analysis Report

The Session Navigation Analysis Report shows how often users click facets or a process 
wizard is invoked.

The results are sorted by Session name. The default view displays:

• Min Select Facet Level – the minimum facet level that the user selected

• Max Select Facet Level – the maximum facet level that the user selected

• Avg Facet Level – the average selected facet level for sessions where at least one facet 
is selected

• Facet Selection Count – the number of facets that users directly selected

• PW Invocation Count – the number of times a process wizard is invoked after it is 
displayed as response

• PW Finished Count – the number of times a process wizard runs to completion after 
it is displayed as a response

• Session Count – the number of sessions covered by the report

You can filter the report data by Year, Quarter, Month, and Confidence Level (see 
Filtering Intelligent Search Analytics Report Displays on page 74 for more information 
on using the Page-By filters).
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You can drill down on a session row to display:

• User Activity Details Report on page 162 

• Question Response Details Report on page 153 

• Concept Details Report on page 159 

• Intent Details Report on page 154

• Intent Response Details Report on page 161 

• Rating Details Report on page 158 

User Feedback Analysis Report

The User Feedback Analysis Report shows user evaluations of the responses returned 
for a question.

The results are sorted by Session name. The default view displays:

• Activity Count – the number of activities for the session

• Click-thru Activity Count – the number of activities for which at least one click-thru 
occurred

• Rating Count – the number of rating responses for the session 

• Comments Count – the number of feedback responses for the session

• Highest Rating – the highest rating for this session

• Lowest Rating – the lowest rating for this session

• Session Count - the number of sessions covered by the report
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You can filter the report data by Year, Quarter, Month, and Confidence Level (see 
Filtering Intelligent Search Analytics Report Displays on page 74 for more information 
on using the Page-By filters).

You can drill down on a session row to display:

• User Activity Details Report on page 162 

• Question Response Details Report on page 153 

• Rating Details Report on page 158 

• Session Navigation Analysis Report on page 149 

• User Feedback Analysis Report on page 150 

• Concept Details Report on page 159 

• Intent/Concept Analysis Report on page 148 
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InQuira Analytics Detail Reports

Detail reports provide activity-level detail for data from standard reports. They carry 
forward the context of the originating report including the report criteria.

NOTE:  Detail reports are available only by drilling down from a standard report, an 
analysis report, or from another detail report. They are not available as stand-alone 
reports.

Detail reports include:

• Intent Details Report on page 154 – which shows how well intents matched user 
questions

• Question Response Details Report on page 153 – which shows how responses are 
used in the system

• Question Details Report on page 154 – which shows the specific questions for the 
current reporting context 

• No Response Question Details Report on page 155 – which shows the specific 
questions for which there was no system response for the current reporting context

• Question Matched No Intent Details Report on page 156 – which shows the specific 
questions for which there was no system intent for the current reporting context

• Question Matched No Intent Response Details Report on page 157 – which shows 
the specific questions for which there was no system intent response for the current 
reporting context

• Rating Details Report on page 158 – which shows user ratings and comments for 
specific questions

• Concept Details Report on page 159 – which shows the session details for a concept

• Words without Concepts Details Report on page 160 – which shows details for a 
word not recognized by the system

• Intent Response Details Report on page 161  – which shows a detailed view of intent 
responses for user questions

• User Activity Details Report on page 162  – which shows how people are using 
activities

• Process Wizard Details Report on page 162 – which shows the process wizards that 
are being used most
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Question Response Details Report

The Question Response Details Report shows how responses are used in the system.

The results are sorted by Session name. The default view displays:

• Question – the specific question for the session

• Response – the response name

• Response Type – the response collection name

• Display Order – the responses display order

• Clicked Thru – whether or not the response is clicked by user: 1 is clicked, 0 is not 
clicked.

• Session Count - the number of sessions covered by the report

You can filter the report data by Year, Quarter, Month, and Confidence Level (see 
Filtering Intelligent Search Analytics Report Displays on page 74 for more information 
on using the Page-By filters).
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Question Details Report

The Question Details Report shows the questions for the current context.

The results are sorted by Question name. The default view displays:

• Question Count – the number of occurrences of the question within the current 
context

You can filter the report data by Year, Quarter, Month, and Confidence Level (see 
Filtering Intelligent Search Analytics Report Displays on page 74 for more information 
on using the Page-By filters).

You can drill down on a session row to display:

• Question Response Details Report on page 153 

Intent Details Report

The Intent Details Report shows how well intents matched user questions for a session.

The results are sorted by Session name. The default view displays:

• Question Count – the number of questions for this session

You can filter the report data by Year, Quarter, Month, and Confidence Level (see 
Filtering Intelligent Search Analytics Report Displays on page 74 for more information 
on using the Page-By filters).
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You can drill down on a session row to display:

• Intent Response Details Report on page 161 

• Rating Details Report on page 158 

• Concept Details Report on page 159 

• Question Response Details Report on page 153

No Response Question Details Report

The No Response Question Details Report shows only the questions for which there was 
no response and is only available from the Queries without Responses Report.

The results are sorted by Question name. The default view displays:

• Question Count – the number of occurrences of the question within the current 
context

You can filter the report data by Year, Quarter, Month, and Confidence Level (see 
Filtering Intelligent Search Analytics Report Displays on page 74 for more information 
on using the Page-By filters).
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Question Matched No Intent Details Report

The Question Matched No Intent Details Report shows the questions for which there 
was no matching intent for the current context.

The results are sorted by Question name. The default view displays:

• Question Count – the number of occurrences of the question within the current 
context

You can filter the report data by Year, Quarter, Month, and Confidence Level (see 
Filtering Intelligent Search Analytics Report Displays on page 74 for more information 
on using the Page-By filters).

You can drill down on a session row to display:

• Question Response Details Report on page 153 
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Question Matched No Intent Response Details Report

The Question Matched No Intent Response Details Report shows the questions for 
which there was no matching intent response for the current context.

The results are sorted by Question name. The default view displays:

• Question Count – the number of occurrences of the question within the current 
context

You can filter the report data by Year, Quarter, Month, and Confidence Level (see 
Filtering Intelligent Search Analytics Report Displays on page 74 for more information 
on using the Page-By filters).

You can drill down on a session row to display:

• Question Response Details Report on page 153 
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Rating Details Report

The Rating Details Report shows user ratings and comments for a specific question and 
response.

 The default view displays:

• Rating – the rating for this question

• Session Count – the number of sessions reported on

You can filter the report data by Year, Quarter, Month, and Confidence Level (see 
Filtering Intelligent Search Analytics Report Displays on page 74 for more information 
on using the Page-By filters).

You can drill down on a session row to display:

• Intent Details Report on page 154

• Intent Response Details Report on page 161 

• Question Response Details Report on page 153 

• Concept Details Report on page 159 
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Concept Details Report

The Concept Details Report shows the session details for a concept.

The results are sorted by Session name. The default view displays:

• Click-thru Question Count – the number of times the question was clicked for the 
session

• Question Count – the number of questions for the session

You can filter the report data by Year, Quarter, Month, and Confidence Level (see 
Filtering Intelligent Search Analytics Report Displays on page 74 for more information 
on using the Page-By filters).

You can drill down on a session row to display:

• Intent Details Report on page 154

• Intent Response Details Report on page 161 

• Question Response Details Report on page 153 

• Rating Details Report on page 158 
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Words without Concepts Details Report

The Words without Concepts Details Report shows details for a word for which there is 
no associated system concept.

The results are sorted by Session name. The default view displays:

• Click-thru Count – the number click-thrus for the question

You can filter the report data by Year, Quarter, Month, and Confidence Level (see 
Filtering Intelligent Search Analytics Report Displays on page 74 for more information 
on using the Page-By filters).

You can drill down on a session row to display:

• Question Response Details Report on page 153 

• Rating Details Report on page 158 
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Intent Response Details Report

The Intent Response Details Report provides a detailed view of intent responses for the 
questions submitted during a user session.

The results are sorted by Session name. The default view displays:

• Highest Displayed Order – the highest order of the response as displayed to the user

• Lowest Displayed Order – the lowest order of the response as displayed to the user

• Click-thru Count – the number of responses clicked

• Max Clicked Order – the maximum order of the response clicked

• Min Clicked Order – the minimum order of the response clicked

You can filter the report data by Year, Quarter, Month, and Confidence Level (see 
Filtering Intelligent Search Analytics Report Displays on page 74 for more information 
on using the Page-By filters).

You can drill down on a session row to display:

• Intent Details Report on page 154

• Concept Details Report on page 159

• Question Response Details Report on page 153

• Rating Details Report on page 158
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User Activity Details Report

The User Activity Details Report shows details about the kinds of activities people are 
using the application to do, and the systems response times for those activities.

The results are sorted by Session name. The default view displays:

• Number of Responses – the number of responses for the activity

You can filter the report data by Year, Quarter, Month, and Confidence Level (see 
Filtering Intelligent Search Analytics Report Displays on page 74 for more information 
on using the Page-By filters).

Process Wizard Details Report

The Process Wizard Details Report shows process wizard user activity details.

The results are sorted by Process Wizard name. The default view displays:

• Step Displayed – the number of times the process wizard step is displayed

• Step Invoked – the number of times the process wizard step is invoked after it is 
displayed

• % Invoked After Displayed – the percentage of times the process wizard step is 
invoked after it is displayed

You can filter the report data by Year, Quarter, Month, and Confidence Level (see 
Filtering Intelligent Search Analytics Report Displays on page 74 for more information 
on using the Page-By filters).
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InQuira Intelligent Search Analytics Attributes and 
Metrics

InQuira Analytics reports are based on a set of defined categories or attributes, and 
associated indicators, or metrics.

• Attributes, or dimensions, are the general categories of business entities that you base 
reports on, such as products, actions, and dates. Attributes can includes one or more 
levels of subcategories. The navigation path down succeeding levels within a 
dimension is called a drill-down path. See InQuira Analytics Attributes on page 171 
for information about the various attributes used in InQuira Analytics.

• Metrics are the quantities that apply to data dimensions. Metrics can be simple sums, 
such as the number of sessions, or calculated values, such as average score. See 
InQuira Analytics Metrics on page 163 for information about the various metrics 
used in InQuira Analytics.

InQuira Analytics Metrics

Question and answer metrics quantify various aspects of the user questions and 
application responses. Metrics objects are grouped into the following folders under 
Metrics in the Object Browser:

• Activity Count Metrics on page 164 

• Concept Metrics on page 164

• Facet Metrics on page 164

• Feedback Metrics on page 165

• Intent Metrics on page 166

• Process Wizard Metrics on page 166

• Prompt Used Metrics on page 167

• Response Click on page 167

• Response Timing on page 168

• Detail Template Metrics on page 168

• Miscellaneous Metrics on page 170
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Activity Count Metrics
The following metrics are located in the Activity Count folder in the Object Browser:

Concept Metrics
The following metrics are located in the Concept folder in the Object Browser:

Facet Metrics
The following metrics are located in the Facet folder in the Object Browser:

Metric Description
Session of >6 Activities The number of sessions with more than 6 activities
Session of >6 and Click-thru The number of sessions with more than 6 activities 

for which at least one click-thru occurred
Session of 1-3 Activities The number of sessions with 1 – 3 activities

Session of 1-3 and Click-thru The number of sessions with 1 – 3 activities for 
which at least one click-thru occurred

Session of 4-6 Activities The number of sessions that have 4 – 6 activities
Session of 4-6 and Click-thru The number of sessions that have 4 – 6 activities for 

which at least one click-thru occurred

Metric Description
Concept  
Descendant Matched Question

The number of questions that match the children of 
a concept

Concept  
Directly Matched Question

The number of questions that directly match a 
concept

Concept  
Distinct Matched Question

The number of questions that distinctly match a 
concept

Metric Description
Facet Selection Count The number of times the facet was selected
Session Select Facet The number of sessions during which this facet was 

selected
Session Select Facet for Prompt The number of sessions where facet level 2 was 

selected
Session with Avg Facet Lv >6 The number of sessions where users selected facets 

with an average level of greater than 6
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Feedback Metrics
The following metrics are located in the Feedback folder in the Object Browser:

Session with Avg Facet Lv >6 and 
Click-thru

The number of sessions where the selected facet 
level was greater than 6 and where at least one 
click-thru occurred

Session with Avg Facet Lv 1-3 The number of sessions where users selected facets 
with an average level between 1 and 3

Session with Avg Facet Lv 1-3 and 
Click-thru

The number of sessions where the selected facet 
level was between 1 and 3 and where at least one 
click-thru occurred

Session with Avg Facet Lv 4-6 The number of sessions where users selected facets 
where the average level is between 4 and 6

Session with Avg Facet Lv 4-6 and 
Click-thru

The number of sessions where the selected facet 
level was between 4 and 6 and where at least one 
click-thru occurred

Metric Description
Max Rating The highest rating for a session
Session Rating Absolutely The number of sessions with a user rating of 

'Absolutely'
Session Rating Hardly The number of sessions with a user rating of 'Hardly'
Session Rating Not Even Close The number of sessions with a user rating of 'Not 

Even Close'
Session Rating Sometimes The number of sessions with a user rating of 

'Sometimes'
Session Rating Usually The number of sessions with a user rating of 

'Usually'
Session with Rating The number of sessions with a user rating
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Intent Metrics
The following metrics are located in the Intent folder in the Object Browser:

Process Wizard Metrics
The following metrics are located in the Process Wizard folder in the Object Browser:

Metric Description
Assigned Intent Response Count The number of questions that match an assigned 

intent response
Inherited Intent Response Count The number of questions that match a system 

defined intent but do not have any assigned 
response where a parent intent's response was 
used

Intent Descendant Match Question 
Count

The number of questions that match the children 
of an intent

Intent Direct Match Question Count The number of questions that directly match an 
intent

Intent Distinct Match Question 
Count

The number of questions that distinctly match an 
intent

Intent Response Count The number of responses for an intent
Question Matched Assigned Intent 
Response

The number of questions that matched an assigned 
intent response

Question Matched Inherited Intent 
Response

The number of questions that matched an 
inherited intent response

Question Matched Intent The number of questions that matched an intent
Question Matched Intent Response The number of questions that matched an intent 

response

Metrics Description

Process Wizard Displayed The number of times a process wizard was 
displayed

Process Wizard Displayed (Prompt) The number of times a process wizard was 
displayed

Process Wizard Finished The number of times a process wizard was 
completed

Process Wizard Invoked The number of times a process wizard was 
invoked
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Prompt Used Metrics
The following metrics are located in the Prompt Used folder in the Object Browser:

Response Click
The following metrics are located in the Response Click folder in the Object Browser:

Metrics Description

Activity Count (Popular Responses) The number of activities for a response
Question Count (Clusters) The number of questions in a question cluster
Question Count (Concept) The number of questions that match a concept
Question Count (Intent Breakdown) The number of questions that directly match an 

intent
Question Count (N Question) The number of questions that match a normalized 

question

Metrics Description

Avg. Clicked Response Order The average position in the response queue of a 
clicked response

Avg. Number of Displayed 
Responses

The average number of responses displayed to the 
user

Displayed Response Count The total number of responses displayed to a user
Ordered >6 The number of activities where the average 

position of the clicked response was greater than 
sixth

Ordered 1-3 The number of activities where the average 
position of the clicked response was between first 
and third

Ordered 4-6 The number of activities where the average 
position of the clicked response was between 
fourth and sixth
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Response Timing
The following metrics are located in the Response Timing folder in the Object Browser:

Detail Template Metrics
The following metrics are located in the Template folder in the Object Browser:

Metrics Description

<4 Seconds The number of activities where the average 
response time was less than 4 seconds

>=30 Seconds The number of activities where the average 
response time was 30 seconds or more

10-20 Seconds The number of activities where the average 
response time was 10 or more seconds and less than 
20 seconds

20-30 Seconds The number of activities where the average 
response time was 20 or more seconds and less than 
30 seconds

4-10 Seconds The number of activities where the average 
response time was 4 or more seconds and less than 
10 seconds

Avg Activity Response Time The average time for the system to respond to 
activities

Metrics Description

(T) Activity Count The number of activities for a session
(T) Click-thru Activity Count The number of activities for a session where a 

click-thru occurred
(T) Facet Selection Count The number of facets that users directly selected
(T) Max Select Facet Level The maximum facet level that a user selected
(T) Min Select Facet Level The minimum facet level that a user selected
(T) Process Wizard Finished The number of times a process wizard runs to 

completion after it is displayed as a response
(T) Question Count
% Invoked after Displayed The percentage of times a process wizard is 

invoked after it is displayed
Activity Displayed Response The number of responses displayed to the user
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Avg Facet Level The average selected facet level for sessions where 
at least one facet is selected

Concept Distinct Matched 
Question <Total Table>

The number of questions that distinctly match a 
concept not including lower levels

Feedback Activity Count The number of activities for a session
Highest Rating The highest user feedback rating for a session
Intent Distinct Match Question 
Count <Total Table>

The number of questions that distinctly match an 
intent not including lower levels

Lowest Rating The lowest user feedback rating for a session
Max Direct Matched Concept 
Count

The maximum number of concepts that match a 
question for a session

Max Direct Matched Intent Count The maximum number of intents that match a 
question for a session

Max Response Click Order The maximum position of responses clicked by the 
user

Max Response Displayed The maximum number of responses displayed for a 
session

Max Response Display Order The maximum position of responses clicked by the 
user

Max Response Time The maximum time for the system to respond to 
activities

Min Direct Matched Concept 
Count

The minimum number of concepts that match a 
question for a session

Min Direct Matched Intent Count The minimum number of intents that match a 
question for a session

Min Response Click Order The minimum position of responses clicked by the 
user

Min Response Displayed The minimum number of responses displayed for a 
session

Min Response Display Order The minimum position of responses clicked by the 
user

Min Response Time The minimum time for the system to respond to 
activities

Process Wizard Step Displayed The number of times a process wizard step is 
displayed

Process Wizard Step Invoked The number of times a process wizard step is 
invoked after it is displayed
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Miscellaneous Metrics
The following metrics are located at the top level of the Metrics folder in the Object 
Browser:

PW Invocation Count The number of times a process wizard is invoked 
after it is displayed as response

Metrics Description

Activity Click-thru Rate The number of activities for a session where at least 
one click-thru occurred

Activity Count The number of activities for a session
Analysis N/A - Reserved for application use
Avg Facet Level The average selected facet level for sessions where 

at least one facet is selected
Click-thru Activity Level The number of activities for which at least one 

click-thru occurred
Click-thru Count The number of click-thrus for a session
Click-thru Question Count The number of questions where at least one click-

thru occurred
Click-thru Response Activity 
Count

The number of activities for the session where a 
click-thru occurred

Click-thru Session Count the number of sessions where at least one click-thru 
occurred

Displayed Count The number of times a response was displayed for a 
session

Facet Level The selected facet level for sessions where at least 
one facet is selected

No Click-thru Question Count The number of questions for which no click-thru 
occurred

No Click-thru Session Count The number of sessions where no click-thru 
occurred

Query Activity Count ignore 
Report Filter

The number of activities for the query, ignoring any 
report filters

Question Click-thru Rate The percentage of questions where a click-thru 
occurred

Question Count The number of questions
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InQuira Analytics Attributes

InQuira Analytics contains various types of attributes that are used in the built-in reports 
as described in InQuira Intelligent Search Analytics Attributes and Metrics on page 163, 
and which you can use to create custom reports, as described in Chapter 7, Creating 
Custom Reports.

Attributes are grouped in folders under Attributes in the Object Browser and include the 
following categories:

• Time attributes, as described in Time Attributes on page 172 

• Concept attributes, as described in Concept Attributes on page 172 

• Facet attributes, as described in Facet Attributes on page 173

• Intent attributes, as described in Intent Attributes on page 174

• Process Wizard attributes, as described in Process Wizard Attributes on page 174 

• Attributes not covered by the categories above in Other Attributes on page 175 

Question Count ignore Report 
Filter

The number of questions, ignoring any report filters

Rating Activity Count The number of activities for a session with at least 
one rating

Response Activity Count The number of responses for an activity
Response Activity Count ignore 
Report Filter

The number of response activities, ignoring any 
report filters

Response Activity with No Click-
thru

The number of responses for an activity where no 
click-thru occurred

Response Click-thru Count The number of responses for an activity where at 
least one click-thru occurred

Response Count The number of responses for a session
Session Click-thru Rate The number of click-thrus for a session
Session Count The number of sessions
Session Count ignore Report Filter The number of sessions, ignoring any report filters
Session with Response The number of sessions with a response
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Time Attributes
Time attributes contain information about the various time intervals in which a question, 
session, or activity occurred. The following Time attributes are located in the Time folder 
in the Object Browser:

Concept Attributes
Concept attributes contain information about concepts found in user questions. The 
following Concept attributes are located in the Concepts folder in the Object Browser:

Attribute Description
Day Specifies the day on which an activity occurred
Hour Specifies the hour in which an activity occurred
Month Stores the month value in which an activity occurred
Quarter Stores the quarter value in which an activity occurred
Question Hour Specifies the hour in which a question occurred
Time Month Specifies the month in which an activity occurred
Time Quarter Specifies the quarter in which an activity occurred
Time Year Specifies the year in which an activity occurred
Week Specifies the week in which an activity occurred

IMPORTANT:  InQuira Analytics defines weeks by date, not 
days. The first week of a month comprises the 
first seven days within that month, regardless of 
the coinciding days of the week (Sunday – 
Saturday).

Year Specifies the year in which an activity occurred

Attribute Description
Concept 
Descendents Match

Specifies whether the concept is descendent matched or not

Concept Direct 
Match

Specifies whether the concept is direct matched or not

Concept Direct 
Match <Total 
Table>

Specifies whether the concept is a direct match or not (used only 
to get data from rep_sess_concept_match table). Does not 
include the level tables

Concept Distinct 
Match

Specifies whether the concept is a distinct match or not
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Facet Attributes
Facet attributes contain information about the facets users click on for a system response. 
The following Facet attributes are located in the Facets folder in the Object Browser:

Concept Distinct 
Match <Total 
Table>

Specifies whether the concept is a distinct match or not (used 
only to get data from the rep_sess_concept_match table). Does 
not include the level tables

ConceptLvl1Node Concept level 1 node. This is the root node
ConceptLvl2Node Concept level 2 node
ConceptLvl3Node Concept level 3 node
ConceptLvl4Node Concept level 4node
ConceptLvl5Node Concept level 5 node
ConceptLvl6Node Concept level 6 node
ConceptLvl7Node Concept level 7 node
ConceptLvl8Node Concept level 8 node
ConceptLvl9Node Concept level 9 node
ConceptLvl10Node Concept level 10 node

Attribute Description
Facet Facet ID
Facet Level Facet level
Facet Lvl1 Node ID for Level 1 node
Facet Lvl2 Node ID for Level 2 node
Facet Lvl3 Node ID for Level 3 node
Facet Lvl4 Node ID for Level 4 node
Facet Lvl5 Node ID for Level 5 node
Facet Lvl6 Node ID for Level 61 node
Facet Lvl7 Node ID for Level 7 node
Facet Lvl8 Node ID for Level 8 node
Facet Lvl9 Node ID for Level 9 node
Facet Lvl10 Node ID for Level 10 node
Facet Select Indicates whether the facet was selected or not. This attributes is 

always 1.
Facet Select <Total 
Table>

Indicates whether the facet was selected or not (used only to get 
data from rep_sess_facet_select table). This attributes is always 1.
Using InQuira Analytics 173



Intent Attributes
Intent attributes contain information about user intents derived from user questions. The 
following Intent attributes are located in the Intents folder in the Object Browser:

Process Wizard Attributes
Process Wizard attributes contain information about how users The following Process 
Wizard attributes can be found in the Process Wizard folder in the Object Browser:

Attribute Description
Distinct Match Specifies whether the intent is a distinct match or not
Intent Descendant 
Match

Specifies whether the intent is a descendant match or not

Intent Direct Match Specifies whether the intent is a direct match or not
Intent Direct Match 
<Total Table>

Specifies whether the intent is a direct match or not (used only 
to get data from rep_sess_intent_match table)

Intent Distinct Match 
<Total Table>

Specifies whether the intent is a distinct match or not (used 
only to get data from rep_sess_intent_match table)

Intent Lvl1 Node ID for Level 1 node
Intent Lvl2 Node ID for Level 2 node
Intent Lvl3 Node ID for Level 3 node
Intent Lvl4 Node ID for Level 4 node
Intent Lvl5 Node ID for Level 5 node
Intent Lvl6 Node ID for Level 6node
Intent Lvl7 Node ID for Level 7 node
Intent Lvl8 Node ID for Level 8 node
Intent Lvl9 Node ID for Level 9 node
Intent Lvl10 Node ID for Level 10 node
Intent Param Intent parameters that were matched for each question during 

request processing

Attribute Description
Last Step Indicates whether a step is the last step for a Process Wizard
Process Wizard Process Wizard name
Step Displayed Indicates whether a Process Wizard step was displayed
Step Invoked Indicates whether a Process Wizard step was invoked by the user
Wizard Step Process Wizard step name
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Other Attributes
The following attributes are not grouped and appear at the root level of the Attributes 
folder:

Attribute Description
-1 Reserved for system use only
Activity A user interaction with the application user interface
Activity Conf 
Level

Confidence level for the activity

Activity Key Value Value for the activity
Activity Response 
Time

Response time for the activity

Activity Type Specific type of interaction with the application user interface or 
user activity

Activity Type 
Page-by

Specific type of interaction with the application user interface or 
user activity. This attribute is used when a report requires two 
activity type objects

Analysis Reserved for system use only
Clicked Thru Indicates whether the user clicked on a system-provided response
Cluster Question cluster name. Clusters are created by detecting portions 

of queries that are similar to each other
Comments Comment text of user feedback
Concept Concept node
Display Order Position of the response in the list of responses displayed for a 

user question
Intent Intent node
Intent Response 
Type

Type of intent response

Language Language specified when an activity occurred
Normalized 
Question

Normalized question

Purpose Name of the portlet associated with a response. Possible values for 
this attribute include any answer purposes defined for the 
application

Qry Src Query source for user question
Question Question text of user question
Question Id ID of user question
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Using the InQuira Analytics Reports (scenarios)

InQuira Analytics provides a set of standard reports to help analyze various aspects of 
customer behavior (customer interests and satisfaction levels), site content, and 
application answer quality and performance.

The InQuira Analytics reports are designed to support the business intelligence activities 
of various managers and staff throughout the organization, including:

• Customer Care Managers and Web Site Designers

Customer Care Managers need to know how effective the self-service system is so that 
they can keep pace with, and respond effectively to, customer problems and emerging 
issues. Web Designers want to assess the user experience to be able to refine site 
structure and presentation to better satisfy customer needs and objectives. User 

Rating User rating for response to a question. Possible values are: No 
Feedback, Not Even Close, Hardly, Sometimes, Usually, 
Absolutely

Rating Activity User interaction that gives a rating
Response System response to a user activity
Response Conf 
Level

System confidence level for the response

Response 
Displayed

Indicates whether a response was displayed to the user

Response Intent Intent matched by response
Response Type Response type
Root Node Root concept node specified by the user
Session ID of the session in which a question was asked, as recorded by 

the InQuira application
Session Page-by ID of the session in which a question was asked. Just used when 

one report include two session object
Session Start Time Time when the user session was initiated
Time Elapsed 
from start session

Time elapsed from the start of the session in which the activity 
occurred

User Segment User Segment to which the user belongs
Words without 
Concepts

Actual text of the unknown word as it occurred in a question
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Experience Scenarios on page 178 contains examples of using InQuira Analytics to 
address customer care and other site usage issues related to InQuira.

• Business Unit Managers, Product Managers, and Marketing Managers

Business Unit Managers, Product Managers, Marketing Managers, and other product 
specialists who want to gain insight into customer questions, interests, and satisfaction 
levels can use InQuira Analytics reports to support decisions about product features, 
promotions, collateral, and other information related to their area of responsibility. 
Product-related Scenarios contains scenarios for investigating product-related issues.

• Operations Managers

Operations Managers who want to understand application resource usage and 
throughput can use InQuira Analytics to support operations activities such as 
determining server allocation and load balancing, and scheduling system upgrades. 
See System Administration Scenarios on page 182 for examples of using InQuira 
Analytics to evaluate InQuira operations.

• Language Administrators

InQuira language administrators who need to monitor, analyze, and maintain the 
language accuracy of the system can use InQuira Analytics to help determine the 
appropriate measures required to optimize application language processing.Language 
Administration Scenarios on page 190 contains examples of investigating language 
accuracy issues.

Using the Scenarios

The InQuira Analytics scenarios in this section guide you through the process of using 
InQuira Analytics to investigate business objectives associated with different types of 
users, from product managers to system administrators.

The examples and data in this section are necessarily general; however, they describe 
practical approaches to achieving the types of objectives associated with the various types 
of InQuira Analytics users.
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User Experience Scenarios

InQuira Analytics provides Customer Care managers and user interface designers with 
information about the way in which users interact with their site. These reports can help 
them identify and escalate the need for new content, re-design pages to highlight useful 
information, or alter the navigational structure to better meet customer objectives. 
Customer Care managers, site designers and others interested in the user experience can 
use reports in the User Experience Analysis area to determine:

• Which facets users are clicking on

• How system responses are being used

• How process wizards are being used 

• How users rate system responses

• User activities that have the highest or lowest click-thru ratings

For the User Experience Analysis area, we will focus on how users rate system responses 
as described in the Customer Feedback Scenario on page 178.

Customer Feedback Scenario
You can use InQuira Analytics to discover questions having answers that are poorly rated 
by customers.

The User Interface contains a mechanism that you can use to solicit user feedback about 
how well the application is answering questions. Refer to Implementing User Feedback 
Collection in the Intelligent Search User Interface Guide for more information on 
implementing the user feedback feature.

The user feedback feature prompts users to rate answers by selecting from the following 
rating levels:

NOTE:  The labels for the rating levels are configurable; InQuira Analytics displays the 
rating levels as they are configured in your application, which may differ from the 
defaults listed above.

Rating Level Default Label
5 Absolutely!

4 Usually

3 Sure

2 Hardly

1 Not even close!
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Questions having negative feedback that are similar in some respect may indicate a 
problem in the application or in the site content.

The User Feedback report, located in the User Experience Analysis area, provides 
information about how customers rated the answers provided by the application.

In this scenario, we will use the User Feedback report to identify the questions that are 
receiving negative feedback.

Reporting on Customer Feedback
The User Feedback report displays the customer rating levels that correspond to the 
selections available on the User Interface answer page. The initial report displays all rating 
levels, the number of questions assigned to each level, and the number of questions that 
were not rated.

In the following scenario, we will use the User Feedback report to examine the questions 
that received negative feedback.

To display the desired report, we will:

• Navigate to the User Feedback report, as described in Displaying the User Feedback 
Report on page 180.

• Drill down to view questions and answers that received negative feedback, as 
described in Displaying Ratings for Individual Questions on page 181.
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Displaying the User Feedback Report
To display user feedback information:

• Select User Experience Analysis > User Feedback Report

• Select the report criteria (see Selecting Report Creation Parameters on page 35 for 

more information) and click 

The User Feedback report displays the rating categories and the percentage of questions 
assigned to each category.
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Displaying Ratings for Individual Questions
To display the user evaluations of the responses returned for individual user questions:

• Right-click on a question row in the Analysis column to display the drill-down menu

• Select User Feedback Analysis

The User Feedback Analysis report shows the user feedback metrics for sessions that 
received feedback sorted by Session name.

The default view displays:

You can continue to drill down to show user evaluations and comments for responses 
within a specific user session:

• Right-click on a session row in the Analysis column to display the drill-down menu

• Select Rating Details

The Rating Details Report shows user evaluations of the responses returned for a 
question for a specific user session.
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System Administration Scenarios

InQuira Analytics provides various reports that provide insight into operational impacts of 
the application. Managers and staff who are responsible for InQuira application 
administration can use various reports to help determine whether to add, remove, or 
balance production servers, when to upgrade the system, or whether or not an upgrade had 
the desired effect on performance by examining factors such as:

• System response times, as described in System Response Time Scenario on page 182.

• The volume of questions being processed by the application, as described in Question 
Volume Scenario on page 185.

• The peak days and times of usage as described in Peak Usage Scenario on page 187.

System Response Time Scenario
You can use InQuira Analytics to determine how long the system is taking to process user 
actions.

In this scenario, we will use the Response Timing report to view response times over a 
time range in specified increments (i.e., monthly, weekly, daily, and so forth).

The Response Timing report, located in the Performance Analysis area, provides 
information about response times grouped by time intervals (i.e., <4 seconds, 4-10 
seconds, 10-20 seconds, 20-30 seconds, >30 seconds).

Reporting on System Response Times
The Response Timing report displays system response times for the application within a 
specified time period. The initial report is configured to display response times for the 
current month.

In the following scenario, we will drill down to examine system response times during the 
current week.

To display the desired report, we will:

• Navigate to the Response Timing report as described in Displaying the Response 
Timing Report on page 183.

• Examine daily response times for the current week as described in Displaying 
Response Time Details on page 184.
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Displaying the Response Timing Report
To display system throughput information for the current week:

• Select Performance Analysis > Response Timing Report

• Select the report criteria (see Selecting Report Creation Parameters on page 35 for 

more information) and click 

The Response Timing report displays a graph and grid (table) showing the percentage of 
user activities for each response time category.
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Displaying Response Time Details
To display response time details for a specific day:

• Right-click on a month (or row for the current time period) in the Month column to 
display the Time Hierarchy drill-down menu.

• Select Day to display daily system response times

The Response Timing report shows response times for each day within the selected time 
range.

• From the Analysis column right-click on the day you want to view response times for.
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• Select Click Thru and Response Time Analysis 

The Click Thru and Response Time Analysis report displays response time data for 
the selected day. You can display report data for other time periods by right-clicking the 
time period and selecting a different view (refer to the section on Drilling Down to More 
Detailed Data on page 39 for more information).

Question Volume Scenario
You can use InQuira Analytics to determine the volume of questions that the application is 
processing.

In this scenario, we will use the Question Usage report to view the number of questions 
handled by the system in the previous week.

The Question Usage report, located in the Question Analysis area, provides 
information about the number of questions processed by the application.

Reporting on the Number of Questions Processed
The Question Usage report displays the number of questions processed by the 
application for a specified time period. The initial report is configured to display the total 
number of questions for the current month.

In the following scenario, we will drill down to examine the number of questions 
processed by the application for the current week.

To display the desired report, we will:

• navigate to the Question Usage report as described in Displaying the Question 
Usage Report on page 186.

• examine the number of questions processed for the current week as described in 
Viewing the Number of Questions Processed on page 187.
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Displaying the Question Usage Report
To display system throughput information for the current month:

• select Question Analysis > Question Usage

• select the report criteria (see Selecting Report Creation Parameters on page 35 for 

more information) and click 

The Question Usage report displays monthly data for questions and associated click-thru 
rates.
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Viewing the Number of Questions Processed
By default, the Question Usage report displays the number of questions processed for 
each month. To view the questions processed for the current week:

• Right-click on the month in the Month column to display the drill-down menu

• Select Drill > Week to drill down to the current week

The Question Usage report displays metrics for questions for the current week. You can 
display report data for other time periods by right-clicking the time period and selecting a 
different view (refer to the section on Drilling Down to More Detailed Data on page 39 
for more information).

Peak Usage Scenario
You can use InQuira Analytics to identify peak application usage periods.

The Activity Usage report, located in the User Experience Analysis area, provides 
information about the number of user activities, such as questions, processed by the 
application for a specific time interval.

In this scenario, we will use the Activity Usage report to determine the day within the 
current week in which the application processed the highest number of user actions.

Reporting on Peak Usage Periods
The Activity Usage report displays the number of user activities, such as questions, 
processed by the application within a specified time period. The initial report is configured 
to display the total number of activities for the current month.

In the following scenario, we will drill down to examine user activities for the current 
week.
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To display the desired report, we will:

• navigate to the Activity Usage report, as described in Displaying the Activity Usage 
Report on page 188.

• drill down to examine totals for the current week, as described in Displaying Activity 
for the Current Week on page 189.

Displaying the Activity Usage Report
To display system usage information for the current and previous month:

• select User Experience Analysis > Activity Usage

• select the report criteria (see Selecting Report Creation Parameters on page 35 for 

more information) and click 

The Activity Usage report displays the activity count and click-thru rate for each time 
period for the report.
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Displaying Activity for the Current Week
By default, the Activity Usage report displays activity data by month. To display the total 
number of questions for the current week:

To display response times for a specific day:

• Right-click on a month (or row for the current time period) in the Month column to 
display the Time Hierarchy drill-down menu.

• Select Drill > Week to display weekly system response times

The Activity Usage report displays the activity volume for the selected week. You can 
display report data for other time periods by right-clicking the time period and selecting a 
different view (refer to the section on Drilling Down to More Detailed Data on page 39 
for more information). 
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Language Administration Scenarios

InQuira Analytics provides reports InQuira administrators can use to improve the overall 
accuracy of the system.

Administrators and other analysts who are responsible for application accuracy can use 
InQuira Analytics information to add required concepts to the Dictionary, add custom 
responses for frequently asked questions, or suggest to site owners that new content be 
created for specific topics. 

InQuira Analytics administrators can use various reports to help identify and respond to:

• Questions that are not being answered well, as described in Poorly Aligned Intents 
Scenario on page 190.

• Questions for which no response was returned, indicating a possible content gap as 
described in Missing Content Scenario on page 192.

• Words that customers are using that the system does not recognize as described in 
Unrecognized Terms Scenario on page 195.

Poorly Aligned Intents Scenario
You can use InQuira Analytics to identify frequent customer questions for which the 
intent response is not well matched to the question.

In this scenario, we will use the Intent Coverage report to view questions that are being 
asked frequently, but are not being matched with an appropriate response.

Reporting on Poorly Matched Intent Responses
The Intent Coverage report displays information about how well intents are aligned with 
user questions. It shows you questions for which there was no intent that matched, and 
intents that were not defined as a response but matched a question.

To display the desired report, we will navigate to the Intent Coverage report as described 
in Displaying the Intent Coverage Report on page 191.
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Displaying the Intent Coverage Report
To display intents metrics for a time range:

• Select Intent Analysis > Intent Coverage Report

• Select the report criteria (see Selecting Report Creation Parameters on page 35 for 

more information) and click 

The Intent Coverage report shows you metrics for the questions that did not match an 
intent or response, or matched either the assigned response or an inherited (parent) 
response.
Using InQuira Analytics 191



Viewing Poorly Matched
To discover if there are any poorly matched intents we can drill down into the Intent 
Coverage Report to view intent metrics listed by session.

To display intents by session using the Intent/Concept Analysis report:

• Right-click on a row for a time period in the Analysis column

• Select Drill > Intent/Concept Analysis

The Intent/Concept Analysis report lists intent metrics, including questions that did not 
match an intent. You can view details for sessions that have unmatched questions by 
drilling down further to either the Intent Details Report or the Intent Response Details 
Report. 

Missing Content Scenario
You can use InQuira Analytics to determine whether poorly answered questions are due to 
missing content that should be added to the site.

In this scenario, we will use the Queries with No Response Report to view activities that 
do not have any response returned.
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Reporting on Questions without Responses
The Queries with No Response Report report displays activities for which no response 
was returned.

In the following scenario, we will use the Queries with No Response Report report to 
identify user questions for which there was no system response.

To display the desired report, we will:

• Navigate to the Queries with No Response Report report, as described in Displaying 
the Queries with No Response Report on page 194.

• Display the Question Details Report to examine questions for which no response was 
returned, as described in Displaying Question Details on page 194.
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Displaying the Queries with No Response Report
To display questions for which no response was returned:

• Select Usage Reports > Queries with No Response Report

• Select the report criteria (see Selecting Report Creation Parameters on page 35 for 

more information) and click 

The Queries with No Response report displays metrics for questions for which no 
response was returned. 

We will continue by drilling down to display the actual questions using the Question 
Details report as described in Displaying Question Details on page 194.

Displaying Question Details
To display questions for which no response was returned:

• From the Queries with No Response report, right-click on Drill To Template
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• Select Drill > Question Details

The Question Details report displays the normalized questions for which no response was 
returned. 

Unrecognized Terms Scenario
You can use InQuira Analytics to identify terms that customers are using that the 
application does not recognize.

The Words without Concepts report, located in the Question Analysis area, provides 
information about words within user questions that are not accounted for in the application 
Dictionary or skip lists.

In this scenario, we will use the Words without Concepts report to identify frequently 
used words that are not recognized.
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Reporting on Unrecognized Words
The Words without Concepts report displays the words that were not recognized by the 
application, ordered by their frequency. The initial report displays words related to all 
products defined within the application reporting hierarchy, for the selected period.

InQuira Analytics reports on unknown words using its language analysis functionality to 
group variations such as plural forms as a single unknown word.

In the following scenario, we will use the Words without Concepts report to identify any 
frequently occurring unknown words.

To display the desired report, we will:

• Navigate to the Words without Concepts report, as described in Displaying the 
Words without Concepts Report on page 196

• Examine the results as described in 

Displaying the Words without Concepts Report
To display the unknown words:

• Select Question Analysis Reports > Words without Concepts Report

• Select the report criteria (see Selecting Report Creation Parameters on page 35 for 

more information) and click 

The Words without Concepts report displays the words occurring in user questions that 
were unrecognized by the application, ordered by frequency. You can drill down on 
individual words to display the questions in which the word occurred as shown in 
Displaying Details for Unknown Words on page 197. 
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Displaying Details for Unknown Words
You can select an unknown word to view the actual questions in which it occurred. 
Viewing the question context may help determine whether or not the word requires an 
associated concept.

To view details for an unknown word:

• Right-click on the word to display the drop-down menu.

• Select Drill > Words without Concepts Details

The Words without Concepts Details report displays for the selected word showing the 
question and session in which the word occurred.

For each word you can see details including the number of questions containing the word, 
the percentage that represents, and the percentage of questions containing the word where 
a click-thru occurred.
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Chapter 6 InQuira Information Manager Analytics 
Reports

Information Manager Analytics contains two types of standard reports: 

• The Information Manager Analytics Reports contain a set of standard reports that 
provide information about how Information Manager content is being used by end 
users. 

• The Information Manager Operational Reports contain a set of standard reports that 
provide information about how content is being managed throughout the publishing 
lifecycle. 
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Information Manager Terminology

The Information Manager Analytics reports and their descriptions refer to the specific 
objects used within an Information Manager application. The following table provides 
brief definitions of some important Information Manager terms. 

Information 
Manager Object

Description

Content Categories Categories enable you to organize application content by any 
characteristic or business requirement, such as product and 
model

Content Channels Channels describe the various types of content (document 
types) used within the application.

Content Records Content records are the individual Information Manager 
documents that contain the application content. Each content 
record belongs to a particular channel; channels define the 
structure for a particular type of document, for example 
customer support case or press release.

Locale Locales are the supported languages for an application.
Repository Repositories contain the content records, user and security 

information, workflow processes, and other information objects 
that you create for your application.

Repository View Repository views are logical collections of repository objects 
that pertain to specific aspects of an organization, such as 
departments or business units.

Workflow Processes Workflow processes are sequences of steps, such as authoring, 
edit, review, and approve, that you can define to enforce 
specific content management procedures for your organization.
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Using the Information Manager Analytics Content 
Categories

Information Manager Analytics provides a set of standard reports that enable you to report 
on Information Manager content usage by content category. Content categories provide 
the mechanism to organize content by any characteristic or business requirement, for 
example, by product and model, so that related content can be managed and presented in 
similar fashion. Every content record belongs to one or more content categories, and 
categories can be defined as hierarchies to reflect any organizational structure.

Content records are the basic units of content in the Information Manager. A content 
record is analogous to an individual document of a particular type, such as a specific 
customer support case or press release. Each type of content record corresponds to a set of 
defined properties called a content channel.

One useful feature of Information Manager is that content records can be associated with 
multiple content categories. However, reporting on content records that belong to multiple 
categories can result in errors when filtering by content channel and content category. In 
such cases, setting the content category filter to TOTAL can result in multiple counting of 
content records that are assigned to multiple content categories.

You access reports containing content category information by selecting them from the 
Shared Reports folder as described in Accessing InQuira Analytics Reports on page 31.

The Information Manager Analytics reports contain a Page-By drop-down list that you can 
use to restrict the report data to a selected content category.

For example, you could generate the Content Usage report showing the total number of 
content records that were accessed through the end-user application during the months of 
August and September, 2006.

The initial report displays the total number of accessed content records in the default 
category set for the report for each week within the specified time period.

You view the total number of accessed content records in another content category by 
selecting the category from the PAGE-BY area.
Using InQuira Analytics 201



Information Manager Analytics Reports

Information Manager Analytics contains a set of standard reports that provide information 
about how Information Manager content is being used by end users. The content analysis 
reports include:

• Content Feedback Report that displays information about end-user ratings of 
published content, based on your application-specific content rating system.

• Content Usage Reports that displays information about the number of published 
content items accessed by end-users, including reports that show content usage greater 
or less than a specified threshold.

• Most Popular Content Report that displays information about the most frequently 
accessed content channels.

• Published Content Report that displays information about the number of records 
published within each channel.

• CaseLink Usage Report that displays information about the number of times a 
solution is linked over a specific time frame.

• Forum Usage Report that displays information about the number of users, new posts, 
and ratings.

• Forum Users Report that displays information about user activities.

• Forum Top Users Report that displays user activity and metrics for a forum.

• Forum Feedback by Category Report that displays forum threads that have received 
low ratings based on a rating threshold.

• Survey Report that displays end user answer survey information for a specified time 
range.

• Workflow Productivity Report that displays information about the average time a 
record remains in a workflow step.

NOTE:  Information Manager Analytics provides a separate set of the standard reports that 
enable you to restrict data by content category, as described in Using the 
Information Manager Analytics Content Categories on page 201.
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Using Information Manager Analytics Reports

You access the standard reports using the Information Manager Analytics application, as 
described in Accessing InQuira Analytics Reports on page 31.

The Information Manager Analytics reports display data within a defined time period, 
which you specify when you access the report. Some reports contain additional creation 
parameters, as described in Information Manager Analytics Report Creation Parameters 
on page 37.

Once you have created a report, you can use additional report features to:

• Restrict the data in the display by Repository, Category, and Locale (language), as 
described in Filtering Information Manager Analytics Report Displays on page 75

• Drill to detailed information, even to the individual content record, as described in 
Drilling to Information Manager Analytics Detail Reports on page 41
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Content Feedback Report

The Content Feedback Report displays information about end-user ratings of published 
content records.

Information Manager provides a facility to define an application-specific rating system to 
collect end-user feedback as described in the section on Updating Labels for the User 
Feedback Report in the Information Manager Administration Guide. Information 
Manager Analytics extracts the user-assigned rating values that end-users have associated 
with each content record and calculates the average value for each content record.

NOTE:  You can define rating systems to use any range of values and to accept free-form 
comments; however, Information Manager Analytics will report only on numeric-
based rating systems.

The results are sorted by time period. The default view displays:

• Rated Content– the number of content items rated for the period

• Total Accessed Content – the total number of content items accessed for the period

• Total Content Ratings – the total number of ratings for the period (there may be more 
than one rating for a content item)
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• % Rated – percentage of activities that were ratings

You can filter the report data by Repository, View, Category, User Group, Channel, 
Locale (language), and Week (see Filtering Information Manager Analytics Report 
Displays on page 75 for more information).

You can also drill down within a selected time period (week by default) to display:

• Content ratings for a day within a selected week

• Content ratings for the month containing the selected week

• Content ratings for the quarter containing the selected week

• Content ratings for the year containing the selected week

• Content ratings grouped by original author

• Content ratings grouped by content owner

• Rated content details, as described in the Rated Content Details Report on page 206

• Rating details, as described in the Rating Details Report on page 207
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Rated Content Details Report
The Rated Content Details Report displays detailed information for a content record. 

The results are sorted by content record. The following detail is included in the report:

Attribute Description
Rating The type of rating
Rating Questions The rating question to which the user responded
Content The ID of the rated content record
Indexer Master 
Identifier

A description of the content

Owner The ID of the user who is assigned as the owner of the 
content record for notification purposes

Date Submitted The date that the content record was saved
Date Last Modified The date that the content record was most recently changed
Date Last Accessed The date that the record was most recently accessed from the 

end-user application
Rated Version The content version when the content was rated
Document Value The sum of all incident values for the cases linked to the 

document
Reuse Count The number of cases linked to the document
Total Content Ratings Total rating for content record for the rating question
Total Content Ratings 
Value

The rating value assigned to the rating question by the user

Average Content 
Ratings

The average ratings value for the rating question
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Rating Details Report
The Rating Details Report displays detailed rating information for a content record. 

The results are sorted by content record. The following detail is included in the report:

Attribute Description
Content The ID of the rated content record
Date/Time The date and time the content was last updated
End User The user who rated the content
Ratings The type of rating
Rating Questions The rating question to which the user responded
Rating Answers The answer to the rating question selected by the user
Rating The rating value assigned to the rating answer
Comments User comments, if any
Count The number of rating answers.
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Content Usage Reports

Information Manager Analytics provides the following Content Usage reports:

• The Content Usage report displays information about the number of published 
content items accessed by end users within the specified time period.

• The Content Usage Greater than Threshold report displays information about the 
number of published content items that have been accessed by end users more times 
than a specified threshold.

• The Content Usage Less than or Equal to Threshold report displays information 
about the number of published content items that have been accessed by end users 
fewer or exactly times than a specified threshold.

• The Content Usage with Threshold report displays information about the number of 
published content items both above and below a specified threshold; when you drill 
into details, the report includes data from both sides of the threshold.

The Content Usage Report displays:

• Accessed Content – the number of published content items that were accessed by 
users

• Document Access Count – the number of times the published content items were 
accessed by users

• Reuse Count – the total number of case links for the contents
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• Document Values – the sum of the incident values associated with the total number of 
case links

You can filter the report data by Repository, View, Category, User Group, Channel, 
Locale (language), and Week (see Filtering Information Manager Analytics Report 
Displays on page 75 for more information). The results are sorted by time period (week 
by default).

You can also drill down within a selected time period (week by default) to display:

• Content access for a day within a selected week

• Content access for the month containing the selected week

• Content access for the quarter containing the selected week

• Content access for the year containing the selected week

• Content access grouped by original author

• Content access grouped by owner

• Content access details, as described in the Accessed Content Details Report on 
page 210
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Accessed Content Details Report
The Accessed Content Details Report displays content and access details for each 
content record included in Content Usage Reports on page 208.

The following detail is included in the report:

• Content ID – the ID of the content record

• Original Author – the ID of the content record's original creator

• Owner – the ID of the user assigned as the owner of the record

• Access Count – the number of times the record was accessed from the end-user 
application

• Date Last Accessed – the date that the record was most recently accessed from the 
end-user application

• Date Last Modified – the date that the record was most recently changed

• Age Since Original Published – the number of days that have elapsed since this 
record was initially made available to the end-user application

• Latest Version – the revision number of the version of the record that is currently 
available to the end-user application
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• Age Since Last Modified – the number of days that have elapsed since this record was 
edited

• Category – the content categories that the record belongs to

Accessed Content Case Link Details Report
The Accessed Content Case Link Details Report displays details for cases associated 
with content records.

The following detail is included in the report:

• Accessed Content – the document ID of the content record

• CaseLink – the case link of the content record

• Case Number – the case number of the case link

• Incident value – the incident value of the case link

• Case Summary – the case link description
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Most Popular Content Report

The Most Popular Content Report displays information about the content channels that 
are most frequently accessed by end-users.

The results are sorted by time period (week by default). The default view displays:

• Activity Count – the total number of content items that were accessed for this channel

You can filter the report data by Repository, View, Category, User Group, Channel, 
Locale (language), and Week (see Filtering Information Manager Analytics Report 
Displays on page 75 for more information).
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You can drill to display:

• Daily content access data for a selected week (row)

• Content access for a day within a selected week

• Content access for the month containing the selected week

• Content access for the quarter containing the selected week

• Content access for the year containing the selected week

• Popular content details, as described in Most Popular Content Details Report on 
page 213

• Content access grouped by original author

• Content access grouped by owner

Most Popular Content Details Report
The Most Popular Content Details Report displays content details for each content 
record included in the Most Popular Content Report on page 212.

The following detail is included in the report:

• Content – the content record ID

• Original Author – the ID of the creator of the content record
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• Owner – the ID of the user who is assigned as the owner of the record for notification 
purposes

• First Publish Date – the date that the record was initially made available to the end-
user application

• Last Publish Date – the date that the record was most recently made available to the 
end-user application

• Date Last Modified – the date that the record was most recently changed

• Access Count – the number of times the record was accessed from the end-user 
application. If the IM record is returned in the search results (but not clicked), it will 
not be counted towards the access count.

• Current Version – the revision number of the version of the record that is currently 
available to the end-user application

• Accessed Version – the revision number of the version of the record that is currently 
displayed

• Indexer Master Identifier – a description of the content
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Published Content Report

The Published Content Report displays information about the number of content items 
published within each channel for a specified time period. You can view the report as a 
graph and a grid:

The Published Content Report displays:

The results are sorted by time period. The default view displays:

• <Channel ID> – Number of content records published for the channel

• Total – the total number of content items that were published for all selected channels
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You can filter the report data by Repository, View, Category, Team, Channel, Locale 
(language), and Week (see Filtering Information Manager Analytics Report Displays on 
page 75 for more information).

You can drill to display:

• Daily content publishing data for a selected week (row)

• Content publishing data for a day within a selected week

• Content publishing data for the month containing the selected week

• Content publishing data for the quarter containing the selected week

• Content publishing data for the year containing the selected week

• Publishing details, as described in Published Content Details Report on page 217

• Content publishing grouped by original author

• Content publishing grouped by owner

• Content publishing grouped by category
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Published Content Details Report
The Published Content Details report displays detailed information for each published 
content record included in the Published Content Report on page 215.

The following detail is included in the report:

• Content – the ID of the content record

• Original Author – the ID of the creator of the content record

• Owner – the ID of the user who is assigned as the owner of the record for notification 
purposes

• Date Submitted – the date that the record was last saved

• Date Published – the date that the record was most recently made available to the end-
user application

• Published Version – the Information Manager-assigned version number associated 
with the currently published version

• Indexer Master Identifier – a description of the content

• Days to Publish – the total number of days that elapsed between initial creation and 
publishing
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CaseLink Usage Report

The CaseLink Usage Report shows the number of cases linked to solutions during a 
specific day, week, month, or over a specified range.

The results are sorted by time period (week by default). The default view displays:

• Reuse Count – the total number of case links for the period

• Document Values – the total sum of incident values for the period

• Average Incident Value – the average incident value for the period

You can filter the report data by Week (see Filtering Information Manager Analytics 
Report Displays on page 75 for more information).

You can drill to display:

• Daily case link usage for a selected week (row)

• Case link usage for a day within a selected week
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• Case link usage for the month containing the selected week

• Case link usage for the quarter containing the selected week

• Case link usage for the year containing the selected week

• Case link details, as described the CaseLink Details Report:

CaseLink Details Report
The CaseLink Details Report shows the number of cases linked to solutions during a 
specific day, week, month, or over a specified range.

The results are sorted by time period (week by default). The default view displays:

• Week – the week covered in the report

• Case Number – the case link number

• Incident Value – the incident value for this case link

• Case Summary – the case summary for the case
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Forum Usage Report

The Forum Usage Report shows the number of registered users, the number of new posts 
for each user, and the number of ratings.

The results are sorted by time period (week by default). The default view displays:

• Total New Topics – the number of new topics posted for the reporting time period

• Total New Questions – the number of new questions posted for the reporting time 
period

• Total Questions Solved – the total number of questions marked as solved

• Total Questions Partially Solved – the total number of questions marked as partially 
solved for the reporting time period

• Total New Replies – the number of replies to a post during the reporting time period

• Total Replies Marked Partially Solved – the total number of replies marked as 
partially solved for the reporting time period

• Total Replies Rated – the total number of replies that were rated during the reporting 
time period

You can filter the report data by Discussion Board, Category, Forum, and Locale 
(language) (see Filtering Information Manager Analytics Report Displays on page 75 
for more information).

You can drill down to display:

• Daily forum usage for a selected week (row)

• Forum usage for a day within a selected week

• Forum usage for the month containing the selected week

• Forum usage for the quarter containing the selected week

• Forum usage for the year containing the selected week
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Forum Users Report

The Forum Users Report shows user activity and metrics for a forum.

The results are sorted by ... The default view displays:

• New Users – the number of users who registered during the reporting time period

• Existing Users – the number of users who were registered prior to the reporting time 
period

• Users Creating Topics – the number of users who posted during the reporting time 
period

• Users Replying – the number of users who replied to a post during the reporting time 
period

• Total Registered – the total number of registered users at the end of the reporting time 
period

You can filter the report data by Repository, User Group, User Locale (language), and 
Week (see Filtering Information Manager Analytics Report Displays on page 75 for 
more information).

You can drill down to display:

• Daily forum user information for a selected week (row)

• Forum user information for a day within a selected week

• Forum user information for the month containing the selected week

• Forum user information for the quarter containing the selected week

• Forum user information for the year containing the selected week
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Forum User Details Report
The Forum User Details Report shows user activity and metrics for a forum.

The following detail is included in the report:

• User – the user name

• Reputation Level – the user's current reputation level

• New Topics – the total number of new topics started by this user

• New Questions – the total number of new questions by this user

• Replies – the total number of replies by this user

• Partially Solved Answers – the total number of replies that are marked as partially 
solved 

• Solved Answers – the total number of replies that are marked as solved 

• Ratings – the total rating count for this user

• Average Rating – the average rating value for this user
222 Using InQuira Analytics



Forum Top Users Report

The Forum Top Users Report shows user activity and metrics for a forum.

The results are sorted by User. The default view displays:

• New Topics – the number of new topics posted by the user

• New Questions – the number of new questions posted by the user

• Replies – the number of replies to questions posted by the user

• Partially Solved Answers – the number of replies marked as partially solved for the 
user

• Solved Answers – the number of replies marked as solved for the user

• Ratings – the total number of ratings for the user

You can filter the report data by User Group, Discussion Board, Forum, and User Locale 
(language) (see Filtering Information Manager Analytics Report Displays on page 75 
for more information).
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Forum Feedback by Category Report

The Forum Feedback by Category Report shows forum threads that have received low 
ratings based on a rating threshold.

The results are sorted by Category. The default view displays:

• Total New Topics – the number of new topics posted for the reporting time period

• Percent of Total Topics – the number of new topics posted for the reporting time 
period

• Total New Questions – the total number of new questions posted for the reporting 
time period

• Total New Replies – the total number of new replies posted for the reporting time 
period

• Replies Marked Solved – the total number of replies marked as solved for the 
reporting time period

• Replies Marked Partially Solved – the total number of questions marked as partially 
solved for the reporting time period

• Replies Rated Above the Threshold – the total number of replies rated that were 
above the specified threshold

• Replies Rated Below the Threshold – the total number of replies rated that were 
below the specified threshold

• Number of User Rating Replies – the total number of replies that were rated during 
the reporting time period

You can filter the report data by Week, Discussion Board, Forum, and Locale (language) 
(see Filtering Information Manager Analytics Report Displays on page 75 for more 
information).
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Survey Report

The Survey Report shows end user answer survey information for a specified time range.

The default view displays:

• Percent – the percentage represented by the answer

You can filter the report data by Repository, Question, View, Category, User Group, 
Channel, and Locale (language) (see Filtering Information Manager Analytics Report 
Displays on page 75 for more information).

You can drill down see the detailed responses to questions for users that answered one or 
more questions as described in the Specific User Response Details Report on page 226.
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Specific User Response Details Report
The Specific User Response Details Report shows the detailed responses to questions for 
users that answered one or more questions.

The following detail is included in the report:

• End User – the number of new topics posted for the reporting time period

• Date/Time – the date and time the question was answered

• User Answer – the user answer

• Text Feedback – the user text feedback
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Workflow Productivity Report

The Workflow Productivity Report shows the amount of time a content record spends in 
a workflow step.

The results are sorted by time period (month by default). The standard report view 
displays:

The Workflow Productivity Report displays information for each available workflow 
process within the selected time frame:

• Workflow – The name of the workflow.

• Week – The week for the workflow.

• Number of Documents Submitted – the number of documents submitted to a 
particular workflow process.
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• Number of Documents Completed – the number of documents completed in a 
particular workflow process.

• Maximum Time to Complete – the maximum time, in days, for a document to 
complete the workflow process.

• Minimum Time to Complete – the minimum time, in days, for a document to 
complete the workflow process.

• Average Time to Complete – the average time, in days, for a document to complete 
the workflow process. 

You can drill down on each listed Workflow to display the details for each item on the 
Workflow Step Productivity Details Report.

Workflow Step Productivity Details Report
By drilling down in the Workflow Productivity Report you will see the Workflow Step 
Productivity Details Report.

The Workflow Step Productivity Details Report displays each step of the selected 
workflow. 

For each step associated with a workflow the Workflow Step Productivity Details Report 
will list:

• Number of Submitted – the number of articles submitted to a particular workflow 
step in the given time frame.

• Number of Approved – the number of articles that have been approved in a particular 
workflow step.

• Number of Rejected – the number of articles that have been rejected from a particular 
workflow step.

• Average Days in Approved – the average number of days to approve an article from 
the workflow step.

• Average Days in Rejected – the average number of days to reject an article from the 
workflow step.
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Information Manager Analytics Attributes and Metrics

Information Manager Analytics reports are based on a set of defined categories or 
attributes, and associated indicators, or metrics.

• Attributes (sometimes referred to as dimensions) are the general categories of business 
entities that you base reports on, such as content channel or end-user rating. Attributes 
can include one or more levels of subcategories. The navigation path down succeeding 
levels within an attribute is called a drill-down path. See Information Manager 
Analytics Reporting Attributes on page 229 for information about the various 
attributes used in Information Manager Analytics.

• Metrics are the quantities that apply to data dimensions. Metrics can be simple sums, 
such as number of times accessed, or calculated values, such as average rating score. 
See Information Manager Analytics Metrics on page 235 for information about the 
various metrics used in Information Manager Analytics.

Information Manager Analytics Reporting Attributes
Information Manager Analytics uses various types of attributes in the standard content 
analysis reports, including:

• The category attribute, as described in Category Attribute on page 230

• Channel attributes, as described in Channel Attributes on page 230

• Content attributes, as described in Content Attributes on page 231

• Expiration attributes, as described in Expiration Attributes on page 232

• Locale attributes, as described in Locale Attribute on page 233

• Rating attributes, as described in Rating Attributes on page 233

• Repository attributes, as described in Repository Attribute on page 233

• Time attributes, as described in Time Attributes on page 234 

• User attributes, as described in User Attributes on page 234

Access Type Attribute
The AccessType attribute represents the type of user access defined within the 
Information Manager application.

Attribute Description
AccessType This attribute stores the type of access used by the user.
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CaseLink Attributes
The CaseLink attributes represent the case-related information for content defined within 
the Information Manager application.

Category Attribute
The category attribute stores information about content categories defined within the 
Information Manager application.

Channel Attributes
The channel attributes represent the content channels defined within the Information 
Manager application.

Attribute Description
CaseLinkForContent This attribute stores the content link for the case.
CaseLink This attribute stores the case link for the content.
Case Number This attribute stores the case number.
Case Summary This attribute stores a summary of the case.
Incident Value This attribute stores the case score for the content.
Document Value This attribute stores the document value for the case.
ReuseCount This attribute stores the number of times that the content was 

used.

Attribute Description
Category (name) This attribute stores the content categories defined in the 

Information Manager application. Possible values are any defined 
category names.

Attribute Description
Channel This attribute stores the content channel name. Possible values 

are any defined channel.
Channel as Page-by The content channel for use as a report filter. Possible values are 

any channels defined within the application.
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Content Attributes
The content attributes represent the content channels defined within the Information 
Manager application.

Attribute Description
Access Count This attribute stores the number of times a content record was 

accessed by end-users.
Accessed Content This attribute stores the content records that were accessed by end-

users.
Avg Days to 
Publish

This attribute stores the average number of days that elapsed 
between content record creation and publishing.

Content Age Since 
Last Modified

This attribute stores the number of days that have elapsed since the 
content record was modified.

Content Age Since 
Original Published

This attribute stores the number of days that have elapsed since the 
content record was originally published (made available to end 
users).

Content Status This attribute stores the current workflow state of the content 
record. Valid values are any defined workflow process steps.

Date Last 
Accessed

This attribute represents the date that the published content record 
was last accessed by an end-user.

Date Last 
Modified

This attribute stores the date on which the content record was last 
modified.

Date Published This attribute stores the date on which the content record was most 
recently published.

Date Submitted This attribute stores the date on which the content record was saved 
to the current workflow step.

First Publish Date This attribute stores the date on which the content record was first 
made available to the end-user application.

Latest Version This attribute stores the major version number for the content 
record, which is assigned when the record is published.

Minor Version This attribute stores the minor version number for the content 
record, which is assigned at each workflow step in the publishing 
process.

Published Content This attribute stores the document IDs of the published content 
record.

Published Version This attribute stores the value of the major version number for the 
currently published content record.

Total Days to 
Publish

This attribute stores the current value of the major version number 
for the content record.
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Expiration Attributes
The expiration attributes store information about added and deleted content records.

Forum Attributes
The forum attributes store data related to user forums.

Attribute Description
Cat-Content 
Added Date

This attribute stores the date that the content record was added to a 
content category.

Cat-Content 
Deleted Date

This attribute stores the date that the content record was removed 
from a content category.

Content Added 
Date

This attribute stores the date that the content record was added to a 
repository.

Content Deleted 
Date

This attribute stores the date that the content record was removed 
from a repository.

Group-Content 
Added Date

This attribute stores the relationship of the Group-Content added 
date.

Group-Content 
Deleted Date

This attribute stores the relationship of the Group-Content deleted 
date.

View-Content 
Added Date

This attribute stores the relationship of the View-Content added 
date.

View-Content 
Deleted Date

This attribute stores the relationship of the View-Content deleted 
date

Attribute Description
Discussion Board This attribute stores the value of discussion board.
Forum This attribute stores the value of forum.
Forum Rating This attribute stores the value of the rating record.
Message This attribute stores the value of message.
MessageType This attribute stores the value of message type.
RatedMessage This attribute stores the value of rated message.
RatingInForum This attribute stores the value of the rated forum.
RatingValue This attribute stores the value of the rating value.
Topic This attribute stores the value of topic.
TopicStatus This attribute stores the value of topic status.
TopicType This attribute stores the value of topic type.
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Locale Attribute
The locale attribute stores the locales (languages) configured within the Information 
Manager application.

Rating Attributes
The rating attributes store information about the content rating records associated with 
Information Manager content. Content ratings are created by end-users through survey 
forms associated with channel content records.

Repository Attribute
The repository attribute represents the content categories defined within the Information 
Manager application.

Attribute Description
Locale This attribute stores the name of the language. Possible values are 

any supported languages configured within the Information 
Manager application.

Attribute Description
Avg Rating This attribute stores the calculated average rating score for the 

content record.
Content with 
Rating

This attribute stores the content that was rated by end-users.

End User This attribute stores the ID of the user who submitted the rating.
Number of 
Ratings

This attribute stores the number of end-user ratings received for 
the content record.

Rating This attribute stores the unique ID of the rating record.
Rating Value This attribute stores the value of the rating record. Possible values 

are any defined rating values defined in the survey.
Text Feedback This attribute stores the text of the user-submitted feedback, if 

available.

Attribute Description
Repos (n) This attribute stores the repositories defined in the Information 

Manager application. Possible values are any defined repository 
names.
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Survey Attributes
The survey attributes store user survey data.

Time Attributes
The time attributes represent the time-based report attributes defined within the 
Information Manager application.

User Attributes
The user attributes represent various relationships between management console users and 
content records.

Attribute Description
Answer This attribute stores the value of a user answer.
Question This attribute stores the value of a user question.
Survey This attribute stores the value of a survey.

Attribute Description
Day This attribute stores the day value.
Month This attribute stores the month value.
Quarter This attribute stores the quarter value.
Week This attribute stores the week value.
Week as Page-by This attribute stores the week value.
Year This attribute stores the year value.

Attribute Description
Documents 
Accessed
Documents 
Authored
Documents Owned
Documents 
Reused
Documents Value
Forum User This attribute stores users who created forum.
Original Author This attribute stores the ID of the user who created the content 

record.
Owner This attribute stores the ID of the user who is assigned as the 

content owner for notification purposes.
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User Group Attribute

View Attribute
The view attribute represents the user response view defined within the Information 
Manager application.

Information Manager Analytics Metrics
Information Manager Analytics contains various types of metrics that are used in the 
standard reports as described in Information Manager Analytics Reports on page 202.

Reputation Level This attribute stores the user reputation level

Attribute Description
UserGroup  

Attribute Description
View This attribute stores the response view. 

Metric Description
Above Threshold This metric is the number of content records having a value, 

such as a content rating, greater than the specified threshold.
Access Count GT 
Threshold

This metric is the number of content records that have been 
accessed a greater number of times than the specified 
threshold.

Access Count LE 
Threshold

This metric is the number of content records that have been 
accessed less than or equal to the specified threshold.

Accessed Content This metric is the number of content records whose average 
rating value is greater than the threshold.

Activity Count This metric is the number of times a content record has been 
accessed by end-users.

Avg Rating This metric is the calculated average rating score derived 
from end-user content ratings.

Below Threshold This metric is the number of content records whose average 
rating value is lower than or equal to threshold.

Published Content This metric is the number of content records that have been 
published.
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Information Manager Operational Reports

Information Manager Operational Reports contains a set of standard reports that provide 
information about how content is being managed throughout the publishing lifecycle. The 
operational reports include:

• Content Aging Report on page 238, which provide information about the length of 
time that published content remains active in the application

• Content Created Report on page 245, which provide information about which users 
have created content, regardless of its state in the workflow cycle. 

• Content Due to Expire Report on page 242, which provide information about content 
records that will expire within a specified time range

• Content in Process Report on page 248, which provide information about the length 
of time that content records remain in workflow processes prior to publication

• Published Content Report on page 251, which provide information about the number 
of content records published in each content channel within a specified time period

NOTE:  Information Manager Analytics provides a separate set of operational reports that 
enable you to restrict data by content category as described in Reporting on 
Information Manager Content Categories

Information Manager Analytics provides operational reports in both grid and graph 
formats. Grid reports display information as text arranged in tables. Graph formats display 
information as either bar graph or pie chart displays.

Using the Operational Reports

You access the operational reports using the Information Manager Analytics application 
as described in Accessing the Operational Reports.

The operational reports display data within a defined time period, which you specify when 
you access the report. Some reports contain additional creation parameters as described in 
Operational Report Creation Parameters on page 37.

Once you have created a report, you can use additional report features to:

• Restrict the data in the display by Repository, Category, and Locale (language) as 
described in Filtering Operational Report Displays on page 76

• Drill to detailed information, even to the individual content record, as described in 
Using the Operational Content Category Reports on page 237
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Using the Operational Content Category Reports
Information Manager Analytics provides a set of operational reports that enable you to 
report on Information Manager content usage by content category. 

NOTE:  See the Information Manager Administration Guide for more information about 
content categories.

One useful feature of Information Manager is that content records can be associated with 
multiple content categories. However, reporting on content records that belong to multiple 
categories can result in errors when filtering by content channel and content category. In 
such cases, setting the content category filter to TOTAL can result in multiple counting of 
content records that are assigned to multiple content categories.

The Analytics Reports contain a Page-By drop-down list that you can use to restrict the 
report data to a selected content category.

For example, you could generate Content Usage report showing the total number of 
content records that were accessed through the end-user application during the months of 
August and September, 2005.

The initial report displays the total number of accessed content records in the default 
category set for the report, for each week within the specified time period.

You view the total number of accessed content records for another content category by 
selecting the category from the PAGE-BY area.

Operations Dashboard

The operations dashboard is a collection of Information Manager Analytics operational 
reports grouped for display on a single page for convenient quick reference.

The dashboard contains the following operational reports:

• Content Aging Report on page 238

• Content Due to Expire Report on page 242

• Content in Process Report on page 248

• Published Content Report on page 251

The dashboard displays the reports in graphical format. You can customize the dashboard 
by changing the contents of the report collection, and by changing the parameters used to 
generate the report data.
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Content Aging Report

The Content Aging report displays information about the length of time that published 
content remains active in the application.

You specify the following parameters to generate the Content Aging report:

See Operational Report Creation Parameters on page 37 for more information.

For grid displays, the data is arranged in a table:

Parameter Description
Published Days Ranges Specify four time ranges to categorize the published 

content. The Content Aging report displays each time 
range as a separate color in the graph report, or a separate 
row in the grid report.

For example, specify 30, 60, 90, 150 to create separate 
report categories for content published:

• less than 30 days

• within 30 to 60 days

• within 60 to 90 days

• within 90 to 150 days
Start date Select or enter the earliest date for which you want to 

include data
End date Select or enter the latest date for which you want to 

include data

Class Count
Each row corresponds to a 
specified range in the report 
definition

The number of content 
records that have been 
published for a number of 
days within the range
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For graph displays, each specified range in the report definition is displayed as a separate 
colored area within the chart:

Specifying Content Aging Parameters
You specify the following parameters to generate the Content Aging report:

Parameter Description
Expiration Ranges Specify up to four time ranges to categorize the content 

records. The Content Aging report displays each time 
range as a separate color in the graph report, or a separate 
row in the grid report.

For example, specify 30, 60, 90, 150 to define separate 
report categories for content aging:

• published 30 days

• published 60 days

• published 90 days

• published 150 days
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See Operational Report Creation Parameters on page 37 for more information. 

Content Aging Description
The Content Aging report displays:

• The number of published content items

• Within each specified time range

• For the specified time period

You can filter the report data by Repository, Channel, and Age of Content.

You can drill down within a selected range to display:

• Content age data grouped by content channel

• Content age data grouped by content owner

• Content age data grouped by original author

• Content age data grouped by category

• Content age data grouped by language

• Content aging detail, as described in Content Aging Detail Report on page 241

Start date Select or enter the earliest date for which you want to 
include data. The specified expiration range values will be 
added to this date to define the report; therefore, this date 
cannot occur in the past.

For example, specify 01/01/2007,and use the expiration 
ranges 30, 60, 90, 150 to view content records that will 
expire:

• on 01/30/2007

• from 01/31 to 3/31

• from 04/01 to 06/29

• from 06/30 to 11/26
End date Select or enter the latest date for which you want to 

include data
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Content Aging Detail Report
The Content Aging Detail report displays the following information for each content 
record included in the report.

Attribute Description
Content ID The ID of the content record
Content Desc The internal content description text
Content Channel The channel that the record belongs to
Original Author The ID of the creator of the content record
First Published Date The date that the record was initially made available to the 

end-user application
Last Published Date The date that the record was most recently made available to 

the end-user application
Owner The ID of the user who is assigned as the owner of the record 

for notification purposes
Days Since Last 
Published Date

The number of days that have elapsed since the record was last 
made available to the end-user application

Days Since First 
Published Date

The number of days that have elapsed since the record was 
initially made available to the end-user application

Current Published 
Version

The revision number of the version of the record that is 
currently available to the end-user application

Content in Process The number of content records that are currently within a 
workflow process

Count The total number of content records
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Content Due to Expire Report

The Content Due to Expire report displays information about content records that will 
expire within a specified time range.

Specifying Content Due to Expire Parameters
You specify the following parameters to generate the Content Due to Expire report:

See Operational Report Creation Parameters on page 37 for more information. 

Parameter Description
Expiration Ranges Specify up to four time ranges to categorize the content 

due to expire. The Content Due to Expire report displays 
each time range as a separate color in the graph report, or a 
separate row in the grid report.

For example, specify 1, 3, 7, 14 to create separate report 
categories for content that is due to expire:

• within 1 day

• within 2 to 3 days

• within 4 to 7 days

• within 8 to 14 days
Start date Select or enter the earliest date for which you want to 

include data. The specified expiration range values will be 
added to this date to define the report; therefore, this date 
cannot occur in the past.

For example, specify 01/01/2007,and use the expiration 
ranges 1, 3, 7, and 14 to view content records that will 
expire:

• on 01/01/2007

• between 01/02 to 01/04

• between 01/05 to 01/11

• between 01/12 to 01/25
End date Select or enter the latest date for which you want to 

include data
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Example Content Due to Expire Grid
For grid displays, the data is arranged in a table:

Example Content Due to Expire Graph
For graph displays, each content channel is displayed as a separate colored bar within the 
chart; each collection of bars represents a specified expiration range:

Class Content <Channel_Name>
Each row corresponds 
to a specified range in 
the report definition

The number of content records in each defined channel. Each 
column represents a defined channel.
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The Content Due to Expire report displays:

• The number of content records that will expire

• Within each defined channel

• Within each specified time range

• For the specified time period

You can filter the report data by Repository, Channel, and Days Due to Expire.

You can drill down within a selected range to display:

• Content expiration data grouped by content channel

• Content expiration data grouped by content owner

• Content expiration data grouped by original author

• Content expiration data grouped by category

• Content expiration data grouped by language

• Content expiration detail, as described in Content Due to Expire Detail Report on 
page 244

Content Due to Expire Detail Report
The Content Due to Expire Detail report displays the following information for each 
content record included in the report.

Attribute Description
Content ID The ID of the content record
Content Desc The internal content description text
Channel The channel that the record belongs to
Original Author The ID of the creator of the content record
First Published Date The date that the record was initially made available to the 

end-user application
Last Published Date The date that the record was most recently made available to 

the end-user application
Owner The ID of the user who is assigned as the owner of the record 

for notification purposes
Days Since Last 
Published

The number of days that have elapsed since the record was last 
made available to the end-user application

Days Since First 
Published

The number of days that have elapsed since the record was 
first made available to the end-user application
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Content Created Report

The Content Created Report displays information on newly created content regardless 
of its state in the workflow cycle.

After selecting the parameters, and selecting run the Content Created Report displays.

The Content Created Report displays the number of documents in a workflow process and 
the amount of documents published for a particular time frame (week by default).

Days Since Last 
Accessed

The number of days that have elapsed since the record was 
accessed by the end-user application

Content in Process The number of content records that are currently within a 
workflow process

Content <Channel> The channel associated with the content
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The Content Created Report allows you to drill down and see the following detailed 
reports for the selected time frame:

• Content Detail

• Group By Channel

• Group by Original Author

• Group by Author

Content Created Detail Report
The Content Created Report allows you to drill down and see the following detailed 
reports for the selected time frame:

• Content Detail

• Group By Channel

• Group by Original Author

• Group by Author
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The Content Created Detail Report displays all the available drill down options:
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Content in Process Report

The Content in Process report displays information about the length of time that content 
records remain in workflows prior to publication. This report only provides in process 
information for content channels that have defined workflow processes.

Specifying Content in Process Parameters
You specify the following parameters to generate the Content in Process report:

See Operational Report Creation Parameters on page 37 for more information.

Parameter Description
In Process Days Ranges Specify up to four time ranges to categorize the content 

records in process. The Content in Process report displays 
each time range as a separate color in the graph report, or a 
separate row in the grid report.

For example, specify 1, 3, 7, 14 to create separate report 
categories for content that has remained in a workflow:

• within 1 day

• within 2 to 3 days

• within 4 to 7 days

• within 8 to 14 days
Start date Select or enter the earliest date for which you want to 

include data
End date Select or enter the latest date for which you want to 

include data
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Example Content in Process Grid
For grid displays, the data is arranged in a table:

The Content in Process report displays:

• Class – a specified range in the report definition

• Count – the number of content records

Example Content in Process Graph
For graph displays, each content channel is displayed as a separate colored section within 
the graph; each collection of bars represents a specified range during which content has 
been in progress.

The Content in Process report displays:

• The number of content records that have remained in a workflow

• Within each specified time range

• For the specified time period

You can filter the report data by Repository, Channel, and Days in Process.

You can drill down within a selected range to display:

• Content in process data grouped by content channel

• Content in process data grouped by content owner
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• Content in process data grouped by original author

• Content in process data grouped by category

• Content in process data grouped by language

• Content in process detail as described in the Content in Process Detail Report on 
page 250

Content in Process Detail Report
The Content in Process Detail report displays the following information for each content 
record included in the report.

Attribute Description
Content ID The ID of the content record
Content Desc The text of the internal content description
Channel The channel that the record belongs to
Original Author The ID of the creator of the content record
Owner The ID of the user who is assigned as the owner of the content 

record for notification purposes
Date Submitted The date that the content was last saved. The date the 

document enters the workflow (that is the date that x.1 version 
is created) is the date submitted. The document can be edited 
and saved throughout the workflow creating x.2, x.3, etc. but 
the date submitted is the date for x.1.

Days at this Workflow 
Step

The number of days that have elapsed since the record entered 
the current step in the workflow process

Workflow Step The current step in the workflow process for the content 
record

Days Since Submitted The number of days since the content was first submitted 
(Current Date - Date Submitted). 

Content URL The URL to the content
Count The total number of content records
250 Using InQuira Analytics



Published Content Report

The Published Content report displays information about the number of content records 
published in each content channel within a specified time period. You can specify a report 
generation parameter to present the published content data on a daily, weekly, or monthly 
basis.

Specifying Published Content Parameters
You specify the following parameters to generate the Published Content report:

See Operational Report Creation Parameters on page 37 for more information.

Parameter Description
Start date Select or enter the earliest date for which you want to 

include data
End date Select or enter the latest date for which you want to 

include data
Publish Range Select one of the following ranges to report on the 

published content records:
Weekly Reports published content on a weekly 

basis. Each row in the grid or group of bars 
in the graph represents a week.

Daily Reports published content on a daily basis. 
Each row in the grid or group of bars in the 
graph represents a day.

Monthly Reports published content on a monthly 
basis. Each row in the grid or group of bars 
in the graph represents a month.
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Example Published Content Grid
For grid displays, the data is arranged in a table:

The Published Content report displays:

• The number of content records that were published

• In each content channel

• Grouped by the specified interval

• For the specified time period

You can filter the report data by Repository, View, Category, User Group, Channel, 
Locale (language), and Week (see Filtering Information Manager Analytics Report 
Displays on page 75 for more information).

You can drill down within a selected range to display:

• Published content details, as described in Published Content Detail Report on 
page 254

• Published content data grouped by content channel

• Published content data grouped by content owner

• Published content data grouped by original author

• Published content data grouped by category

• Published content data grouped by language
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Example Published Content Graph
For graph displays, each content channel is displayed as a separate colored bar within the 
chart; each collection of bars represents the specified range:

The Published Content report displays:

• The number of content records that were published

• In each content channel

• Grouped by the specified interval

• For the specified time period

You can filter the report data by Repository, Channel, New or Modified Content, and 
Time Range.

You can drill down within a selected range to display:

• Published content data grouped by content channel

• Published content data grouped by content owner

• Published content data grouped by original author

• Published content data grouped by category

• Published content data grouped by language

• Published content details, as described in Published Content Detail Report on 
page 254
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Published Content Detail Report
The Published Content Detail report displays the following information for each content 
record included in the report.

User Reputation Report

The User Reputation Report shows content authors, the documents they own, and the 
reputation levels they have achieved.

The results are sorted by User. The default view displays:

• Reputation Points – the total reputation points accumulated by the author

• Documents Owned – the number of documents with the current user marked as the 
document owner

• Documents Authored – the original author of the document 

Attribute Description
Content ID The ID of the content record
Content Description The internal content description text
Content Channel The channel that the content record belongs to
Original Author The ID of the creator of the content record
Owner The ID of the user who is assigned as the owner of the content 

record for notification purposes
Submitted Date The date that the content was last saved
Published Date The date that the content record was most recently made 

available to the end-user application
Published Version The revision number of the version of the content record that 

is currently available to the end-user application
Days to Publish The number of days elapsed between content creation and 

publishing
Count 
<Channel_Name>

The total number of content records for the channel
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• Document Reuse – the number of times a case link has been made to this content 

• Document Value – the incident value of the content 

• Document Access – the content metrics data for the content record.

• Reputation Level – the user's reputation level.

Translation Sync Report

The Translation Sync Report reports on content that is out of sync with it's originating or 
master content. For example, if the English version of a document is updated, the 
translated documents based on that document will be out of sync unless they are similarly 
updated.

The results are sorted by ... The default view displays:

• Master Doc ID – name of content 

• Master Version – the master content version

• Last Modified Date – the master content's last modified date 

• Translated Locale – the locale of the translated content 

• Last Modified Date – the translated content's last modified date 

• Translated Based Version – the translated content's base version

• Translated Own Version – the translated content's own version

You can filter the report data by Repository, Channel, and Locale (language) (see 
Filtering Information Manager Analytics Report Displays on page 75 for more 
information).
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Information Manager Operational Report Attributes

Information Manager Analytics reports are based on a set of defined categories or 
attributes. Attributes (sometimes referred to as dimensions) are the general categories of 
business entities that you base reports on. Attributes can include one or more levels of 
subcategories. The navigation path down succeeding levels within an attribute is called a 
drill-down path.

Operational Report Attributes
The channel attributes represent the content channels defined within the Information 
Manager application.

Attribute Description
Category 
Group by 
Category

This attribute stores the content categories defined in the 
Information Manager application. Possible values are any defined 
category names.

Channel 
Group by Channel

This attribute stores the content channel name. Possible values are 
any defined channel.

Content Type This attribute stores the content type.
Locale (Language) 
Group by 
Language

This attribute stores the name of the language. Possible values are 
any supported languages configured within the Information 
Manager application.

Original Author 
Group by Author

This attribute stores the ID of the user who created the content 
record.

Owner 
Group by Owner

This attribute stores the ID of the user who is assigned as the 
content owner for notification purposes.

Repository This attribute stores the repositories defined in the Information 
Manager application. Possible values are any defined repository 
names.

Week This attribute stores the date by week.
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Chapter 7 Creating Custom Reports

You can create custom reports using the features of the InQuira Analytics user interface 
to:

• Modify an existing report by adding, modifying, or deleting the attributes within the 
report definition, as described in Modifying an Existing Report on page 257 

• Define a new report by creating a new report definition, as described in Creating a 
New Report on page 262

Refer also to the supporting MicroStrategy product documentation for detailed 
information on creating custom reports.

Modifying an Existing Report

You can modify an existing report by modifying the values of its current attributes and by 
adding attributes to the report definition.

You add attributes to a report definition by:

• Navigating to the existing report

• Changing the report view to Design mode

• Adding selected attributes from the Object Browser

You can save modified reports to overwrite existing reports, or rename the modified report 
to save it as a new report.

You can make modified reports available to users as shared reports, or save them in 
individual user folders.
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Changing the Report View to Design Mode

To change a report view to Design Mode:

• Select Design mode from the View menu:

or from the Function icons:

The report displays in design mode, displaying the objects and attributes defined for the 
current report:
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Displaying Report Attributes

The Report Objects list in the Object Browser section displays the objects that are 
currently defined for the report.

NOTE:  The Object Browser displays the objects that are currently used in the report 
definition. You can display all the available objects defined in the project by 
selecting All Objects. See Displaying Project Objects on page 264 for more 
information on adding project objects to a report definition.

Adding a Currently Defined Object to the Default View

You can add currently defined attributes to the report to display multiple dimensions 
within the same view. Attributes that are already defined for the report appear in the 
Object Browser in the Report Objects tab.

To add the Activity Type dimension to the initial report view:
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• Select the Activity Type dimension from the Report Objects list and drag it to the 
report template

The report now shows the new report view with the Activity Type dimension:

You can save your changes by saving the existing report, or by saving the modified report 
as a new report, as described in Saving New and Modified Reports on page 268.

Deleting Objects from a Report Display

You can delete an object from a report view from within Design Mode by selecting the 
desired object and using the delete function.

To delete an object from the report display:

• Select the object by right-clicking the column heading in Design Mode
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The drop-down menu displays.

• Select the Remove from Grid option

The selected object is deleted from the report display; however, it is still included in the 
report definition and the Report Objects list.

Deleting Objects from a Report Definition

You can delete an object from a report definition within Design Mode by selecting the 
desired object and using the Remove from Report option.

To delete a report object:

• Select the object by right-clicking it in the Report Objects list

The drop-down menu displays.

• Select the Remove from Report option

The selected object is deleted from the report definition.
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Creating a New Report

You can create a new report from any objects defined in the project. For example, you 
could create a new report to show questions, the corresponding number of responses, and 
the number of responses that matched an intent.

You can make new reports available to users as shared reports, or save them in individual 
user folders.

To create a new report:

• Select Create Report from the menu bar

The Create Report options page displays.

• Select the Blank Report option
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The Design Mode page displays a blank report template.

Creating a New Report in Design Mode

The Design Mode report template displays:

• The Object Browser, which lists All Objects (the Attributes and Metrics defined for 
the project)

• The report view columns, which are empty until you add attributes from the All 
Objects list
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Displaying Project Objects

The Object Browser displays the objects that are currently used in the report definition. 
You can display all the available objects defined in the project by selecting All Objects.
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The Attributes and Metrics folders contain all of the attributes and metrics defined for the 
project. For example, you can select the Attributes folder to display all of the Attributes 
defined for the project.
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Adding Attributes and Metrics to a Report

To add attributes and metrics to a new report:

• Select the desired attribute from the attributes list, for example, Normalized 
Question, and drag it to the report template

The Normalized Question attribute is added to the report template.
• Navigate to the All Objects list and select the Metrics folder to display the metrics 

defined for the current project

• Select the desired metrics, for example, Response Count and Question Matched 
Intent Response, and drag them to the report template

The Response Count and Question Matched Intent Response metrics are added to 
the report template.

For a list of all system attribute and metric objects and what they reference, refer to the 
section on InQuira Intelligent Search Analytics Attributes and Metrics on page 163.
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Executing New and Modified Reports

You can execute a new or modified report from the Design Mode page to determine 
whether you want to save it in your reports collection.

To run a new or modified report:

• select the Run Report option above the Object Browser

The report builder creates and displays the new report.

You can save the report, as described in Saving New and Modified Reports on page 268.
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Saving New and Modified Reports

You can save new reports using the Save Report options on the Design Mode page.

• Select the Save Report option above the Object Browser

The Save Report page displays:

The Save Report page provides options to specify:

Parameter Description
Save in: Specifies the folder in which to save the report. Select 

Shared Reports, My Reports, or create a new folder. The 
contents of the currently selected folder are displayed in 
the Contents of this folder field.

Name: Specifies a name for the report.
Description: Specifies a description for the report.
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Chapter 8 The Log Data Archive

The log extraction task stores compressed versions of the logs in an archive directory in 
the InQuira Analytics instance. You can use the archive directory to create archive copies 
of the logs if desired. 

The location of the archive directory is specified on the Analytics page of the Advanced 
Configuration Facility. The default archive directory is data/archive.

Configuring Data Archive

Data Archive is used to prune historical data from the current ODS schema to the Archive 
ODS schema. 

Before starting the archive process, make sure that you have a datasource set up for the 
archive database. The archive schema must be located in a different database schema from 
the ODS schema. Currently, the archive schema must reside on the same SID (Oracle) or 
the same database instance (SQL Server) as the ODS schema, and the two schemas must 
be associated with the same database vendor. For example, they must both be either 
Oracle or MSSQL schemas. This is necessary because each vendor has different variations 
of SQL. Both data sources are configured within the Analytics page of the Advanced 
Configuration Facility.

Creating the Data Archive

If the archive schema has not been created, run the following command from the ICE 
environment:

         scheduler run DBInterface -c odsarchive

• Make sure that the archive schema is up to date before running the archive process 
(ICE environment)

         scheduler run DBInterface -u odsarchive
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• Make sure there is adequate disk space to store the amount of records to be archived. 
The archive process copies all records with REP_GLBL_* to the archive schema. The 
tables named REP_SESS* contain the older records to be copied to the archive schema 
and then deleted from the ODS schema. Currently the MS_IM* tables are not 
archived.

• Set the configuration parameters, commit-batch-size and keep-month. 

- The commit-batch-size parameter is used to set the number of records that are 
batched for UPDATE, DELETE or INSERT before a database commit is executed. 
The larger the number, the faster the archiving and log loading processes will be. 
However, the larger this parameter is, the more temp space and database locks are 
used. The default is 100. 

- The keep-month parameter is the number of months to be retained in the ODS 
schema. The default is 4 months.
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Updating the Data Archive Configuration

On the Analytics page of the Advanced Configuration Facility you may configure how 
many months data to keep in the ODS schema after running the data archive command. 
The default value is three months.

If you change the default value or make any other configuration changes after creating the 
Data Archive, you must run the following script in the ICE prompt:

scheduler run DBInterface -u odsarchive

Manually Archiving Data

To move data from the ODS schema to the Archive ODS Schema enter the following 
command into the ICE Prompt:

scheduler run Analytics -ao

Deleting Data from the Archive

To delete the data stored in the Archive ODS schema from the system enter the following 
command into the ICE Prompt:

scheduler run DBInterface -d odsarchive
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Viewing Archived Data

It is possible to view data after it has been archived. To do this you must change the 
Intelligent Search Analytics database instance from its current datasource to the Archive 
ODS datasource.

Create ODBC DSN for Archive Database

• Open the ODBC Data Source Administrator Panel.

(For Windows, click Start > Administrative Tools > Data Sources (ODBC)

• Select the System DSN tab and click Add.

• Create a new ODBC DSN that points to the archive ods database.

You must then configure the Intelligent Search Analytics Warehouse instance to point to 
the Archive ODS

Modifying the Intelligent Search Analytics Datawarehouse

To modify the Intelligent Search Analytics archive datawarehouse:

• Open System Manager.

• Under Tools select Advanced Config.

• Select Analytics.

• Select Edit.

• Select the Archive Datasource from the drop down list, or edit list.
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